
 

 

 

 

 

PADS Layout Tutorial 
 
 

  

  
 

 

 

 

 

 
 

© 1987-2012 Mentor Graphics Corporation 
All rights reserved. 

This document contains information that is proprietary to Mentor Graphics Corporation. The original 
recipient of this document may duplicate this document in whole or in part for internal business purposes 
only, provided that this entire notice appears in all copies. In duplicating any part of this document, the 
recipient agrees to make every reasonable effort to prevent the unauthorized use and distribution of the 
proprietary information. 

 

 



Learning the User Interface 2 

This document is for information and instruction purposes. Mentor Graphics reserves the right to make 
changes in specifications and other information contained in this publication without prior notice, and the 
reader should, in all cases, consult Mentor Graphics to determine whether any changes have been made. 

The terms and conditions governing the sale and licensing of Mentor Graphics products are set forth in 
written agreements between Mentor Graphics and its customers. No representation or other affirmation of 
fact contained in this publication shall be deemed to be a warranty or give rise to any liability of Mentor 
Graphics whatsoever. 

MENTOR GRAPHICS MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. 

MENTOR GRAPHICS SHALL NOT BE LIABLE FOR ANY INCIDENTAL, INDIRECT, SPECIAL, OR 
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING BUT NOT LIMITED TO LOST PROFITS) 
ARISING OUT OF OR RELATED TO THIS PUBLICATION OR THE INFORMATION CONTAINED IN IT, 
EVEN IF MENTOR GRAPHICS CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 

RESTRICTED RIGHTS LEGEND 03/97 

U.S. Government Restricted Rights. The SOFTWARE and documentation have been developed entirely at 
private expense and are commercial computer software provided with restricted rights. Use, duplication or 
disclosure by the U.S. Government or a U.S. Government subcontractor is subject to the restrictions set 
forth in the license agreement provided with the software pursuant to DFARS 227.7202- 3(a) or as set forth 
in subparagraph (c)(1) and (2) of the Commercial Computer Software - Restricted Rights clause at FAR 
52.227-19, as applicable.  

Contractor/manufacturer is: 
Mentor Graphics Corporation 

8005 S.W. Boeckman Road, Wilsonville, Oregon 97070-7777. 
Telephone: 503.685.7000 

Toll-Free Telephone: 800.592.2210 
Website: www.mentor.com 

SupportNet: supportnet.mentor.com/ 
Send Feedback on Documentation: supportnet.mentor.com/user/feedback_form.cfm 

 

TRADEMARKS: The trademarks, logos and service marks ("Marks") used herein are the 
property of Mentor Graphics Corporation or other third parties. No one is permitted to use 
these Marks without the prior written consent of Mentor Graphics or the respective third-party 
owner. The use herein of a third- party Mark is not an attempt to indicate Mentor Graphics as 
a source of a product, but is intended to indicate a product from, or associated with, a 
particular third party. A current list of Mentor Graphics’ trademarks may be viewed at: 
www.mentor.com/terms_conditions/trademarks.cfm. 

End-User License Agreement: You can print a copy of the End-User License Agreement from: 
www.mentor.com/terms_conditions/enduser.cfm.

http://www.mentor.com/
http://supportnet.mentor.com/
http://supportnet.mentor.com/user/feedback_form.cfm
http://supportnet.mentor.com/user/feedback_form.cfm
http://supportnet.mentor.com/user/feedback_form.cfm
http://www.mentor.com/terms_conditions/trademarks.cfm
http://www.mentor.com/terms_conditions/enduser.cfm


Table of Contents 

Learning the User Interface .......................................................................... 1 
Creating Library Parts .................................................................................. 7 
Preparing a Design ..................................................................................... 16 
Importing Design Data ................................................................................ 25 
Importing Schematic Data .......................................................................... 27 
Assigning Constraints ................................................................................ 32 
Moving and Placing Components .............................................................. 35 
Creating and Editing Traces ....................................................................... 42 
Creating Traces with Dynamic Route ........................................................ 53 
Autorouting with PADS Router .................................................................. 58 
Creating Split Planes .................................................................................. 61 
Creating Copper and Pour Areas ............................................................... 65 
Adding Dimensioning ................................................................................. 68 
Checking for Design Rule Violations......................................................... 72 
Updating the Schematic ............................................................................. 75 
Creating Reports and CAM Files ............................................................... 78 



Learning the User Interface 1 

Learning the User Interface 

The PADS Layout user interface is designed for ease of use and efficiency. PADS 
Layout is designed to meet the needs of the power user, while keeping the 
beginner in mind. PADS Layout’s interface and interaction are similar to other 
Windows ™ applications. You can interact with PADS Layout using the 
keyboard, menus, toolbars, and shortcut menus. 

In this lesson: 

 Shortcuts 
 Using the workspace 
 Setting units of measure 
 Setting grids 
 Panning and zooming 
 Selecting objects 

Preparation 

If it is not already running, start PADS Layout. 

Shortcuts 
 

You can use keyboard shortcuts to start commonly used commands or to set 
options. You will use some of the shortcuts throughout the tutorial. 

Keyboard shortcut types: 

Shortcut type Description 
Modeless 
Commands 

Commands invoked through the keyboard. The available 
commands handle display options, design settings, and 
mouse click substitutions. 

Shortcut Keys Commands that change settings or execute commands 
without using the mouse. Windows standard shortcut keys, 
such as Alt+F to open the File Menu, are also used. 
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Using the workspace 
 

The default workspace measures 56 inches by 56 inches. The origin of the 
workspace, or 0,0 coordinate location, is represented by a large white marker. 
When you start PADS Layout or open a new file, the origin is centered in the 
window at a medium magnification. 

Move the origin 

To relocate the design origin: 
1. Setup menu > Set Origin. 
2. Click in the workspace to indicate a new position for the origin. 

Pointer position display 

As you move the pointer around the workspace, its position, in absolute X,Y 
coordinates relative to the origin, appears on the Status Bar in the lower right 
corner of the screen. Throughout tutorials you will be required to refer to this 
coordinate data. 
1. Place the pointer over the origin and note the 0,0 reading on the Status Bar. 
2. Move the pointer around the workspace and note how the X,Y coordinates 

change as the pointer position changes. 

Setting units of measure 
 

To change the unit of measure to inches, mils (default setting), or metric units, 
click Options on the Tools menu. The Design Units settings are on the Global > 
General page of the Options dialog box. Leave the current setting of Mils.  

Setting grids 
 

There are two kinds of grids: working grids and display grids. 

Working grids 

Working grid types: 

Grid Description 
Design Grid Establishes the minimum snap distance for the pointer when 

editing. 
Via Grid Establishes the spacing and location of vias. 
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Display grid 

This dot-type grid is a visual aid. You can set the display grid to match your 
design grid, or you can set it at larger or smaller multiples of the design grid. 
1. Tools menu > Options > Grids and Snap > Grids page 
2. To disable the display grid, set both coordinates of the Display Grid to a small 

value, such as 10. It is not really disabled, but you will not see it unless you 
zoom in significantly. 

Grid exercise 

The spacing for each grid can also be set by using modeless commands. In 
the following exercise, you'll use modeless commands to set the design and 
display grids. 
1. If the Grid tab of the Option dialog box is open, click in the workspace to 

make it the active window. Do not close the dialog box. 
2. Type gd, for display grid. The modeless command dialog box opens with the 

characters gd in the box. 
3. Type 500 and press Enter. Note that the settings in the display grid area 

update in the dialog box and a corresponding message appears in the Status 
Bar, located in the lower left corner. 

4. Close the Options dialog box. 
Requirement: You may have to zoom in or out to see the display grid; the 
ability to view the display grid depends on the grid value entered. See the 
"Using Pan and Zoom" topic. 
Alternative: You can also set the design grid in one step by typing the 
modeless command gr500 and pressing Enter. It’s best to use a space 
between the modeless command and the value. It’s required in PADS Router. 

Tips:  
 Use the g modeless command for global grid settings. Entering g500 sets the 

design grid and via grid to 500 mils.  
 To set the via grid separately, type gv and press Enter.  
 Instead of specifying a single variable, you can type one of the grid modeless 

commands and use two variables where xy equals a separate rise and run of 
the grid spacing (gv 50 10). 

Panning and zooming 
 

Open a previously saved file 

To make it easier to view changes in magnification, open the file named 
preview.pcb in the \PADS Projects\Samples folder. 
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Tip: Because any operation is considered part of new file creation, including the 
shortcut menu and grid exercises you just performed, a dialog box appears 
prompting you to save the old file. Click No. 

Zoom 

Several methods exist for controlling the centering and magnification of a design. 
In this exercise, you are going to use the mouse. 
For two-button mouse operations, the Zoom button enables and disables Zoom 
mode. Clicking Zoom from the View menu can also enable it. While in Zoom 
mode, the pointer changes to a magnifying glass. For three-button mouse 
operations, Zoom mode is always available using the middle mouse button.  
Tip: Because some manufacturers give the center mouse button a specific 
function, you may need to de-activate default middle mouse button functionality 
before you can use these features in PADS Layout. Change mouse functionality 
using the Control Panel. 
Zoom in and out by placing the pointer at the center of the area and dragging in 
a specific direction. Pan and Zoom functions are also available using commands 
from the View menu, using the numeric keypad, and using the Windows scroll 
bars. See PADS Layout Help for more information on Pan and Zoom functions. 

Practice zooming 

The following procedure assumes you are using a two-button mouse except 
where noted. 

1. Zoom button  
Exception: If you are using a three-button mouse, skip this step. 

2. Zoom in. 
a. Click and hold the left mouse button in the center of the object or area you 

want to magnify. 
Exception: If you are using a three-button mouse, click and hold the middle 
mouse button. 
b. Drag the pointer upward, moving the mouse away from you. A dynamic 

rectangle attaches to and moves with the pointer.  
c. When the rectangle encompasses the area you want to magnify, release 

the mouse button to complete the operation. 
3. Zoom out. Repeat Step 2, but drag the pointer downward, moving the mouse 

towards you. A static rectangle, representing the current workspace view, 
appears with a dynamic rectangle representing the new view of the 
workspace.  

4. Practice using Zoom mode to adjust the magnification.  
Tip: To re-establish the original view, click Board on the View menu. 
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5. If you are not using the middle mouse button, click the Zoom button again to 
end Zoom mode. 

Practice panning 

1. Point to the center of the new view. 
2. Click the middle-mouse button. 

Selecting objects 
 

During the many phases of the PCB process, you may want to select only specific 
objects. For example, during component placement you may want to limit 
selections to components and during interactive routing you may want to limit 
selections to connections or routes. 
To accommodate this working preference, there is a Selection Filter. With the 
Selection Filter, you can specify which design objects are selectable. Items turned 
off in the list can't be selected. 

Selection Filter 

Objects are organized into two categories: Design Items and Drafting Items. 
Layers can also be filtered. 
1. With nothing selected, right-click and click Filter. 

Alternative: Press Ctrl+Alt+F to open the Selection Filter dialog box.  
2. Click Anything to enable selection of all objects. 
3. Click Parts to disable part selection.  
4. Leave the Selection Filter open and click in the design window to make 

it active. 
5. Place the pointer over a component outline and click to select it. You cannot 

select it. 
6. Place the pointer over an object other than a component and select it. You can 

select other objects. 
7. Deselect all objects by clicking in an open area. 

Selection Filter shortcuts 

Tip: You can quickly change Selection Filter settings using the filter presets on 
the right-click menu. 
1. With nothing selected, and the Selection Filter dialog box open, right-click 

and click Select Nets.  
Result: The Selection Filter updates to allow selection of nets only.  

2. Right-click and click Select Anything.  
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Result: The Selection Filter updates to allow selection of almost any object. 
Only Clusters, Unions, Pin Pair, Nets and Board Outline are still turned off. 

3. Click Close to close the Selection Filter dialog box. 

Selecting all objects of one type 

You can use the Selection Filter or the selection shortcuts to select all items of 
one object type. 
1. To bring the whole design in view, press Ctrl+B, the View > Board shortcut. 
2. With nothing selected, right-click and click Select Components. 
3. Right-click again and click Select All to select all the components in  

the design. 
4. To deselect the selected components, press Esc. 

Cycling selections 

Selecting a particular object may take a few tries in a crowded area. To eliminate 
multiple selection attempts, you can cycle through all of the objects near a 
current selection. 

To cycle selections: 

1. Right-click and click Select Anything.  
2. Type su1.28  to search for pin 28 of component U1. The pointer positions over 

the center of pin 28 of U1.  
3. Press Spacebar to select 28. 
4. Press Tab on the keyboard repeatedly to cycle through all of the selectable 

objects in the vicinity of pin 28.  
5. Stop cycling when you select the item you want. 
6. Do not save a copy of the design. 

You completed the user interface tutorial. 
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Creating Library Parts 

You create the library elements that compose a part type in the PADS library 
using the Library Manager and the PCB Decal Editor.  

In this lesson: 

 Understanding the PADS part type and PCB decal 
 Creating a PCB decal 
 Adding keepouts to a PCB decal 
 Assigning PCB decal attributes 
 Adding attribute labels to a PCB decal 
 Creating a new part type 
 Creating PCB decals using the Decal wizard 

Restriction 

This tutorial requires the Drafting Editing, General Editing and Library Editor 
licensing options.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout. 

Understanding the PADS part type and PCB decal 
 

Part Type 

Before you can add a part to a design, it must exist as a PADS part type in the 
library. A part type is composed of three elements:  
 The schematic symbol, or Logic decal as it is called in the library 
 A component footprint, or PCB decal as it is called in the library 
 Electrical parameters, such as pin numbers and gate assignments 
An example of a PADS Layout part type is a 7404.  



Creating Library Parts 8 

 

Element Description 
Part type name 7404 
Logic decal INV (inverter) 
PCB decal DIP14 (14 pin dual in-line package) 
Electrical parameters Six logical gates (A through F) using 12 of the 14 pins 

with one power pin and one ground pin. 
You can create a part type in PADS Logic or in PADS Layout; however, you can 
only create a Logic decal in PADS Logic, and a PCB decal in PADS Layout. 

PCB decal editor 

The PCB decal is the physical representation of the part, often called its 
footprint. The PCB decal contains a number of terminals representing 
component pins and a component outline. You create PCB decals in the PCB 
Decal Editor.  

On the Tools menu, click PCB Decal Editor. 

Once you enter the PCB Decal Editor, text labels and a PCB decal origin marker 
appear: 
 The NAME text label is a placeholder for the reference designator of the part. 
 The TYPE text label is a placeholder for the part type name of the part. 

Wherever you position these labels in the decal is where the reference 
designator or part type appears when a component using the PCB decal is 
added to the design.  

 The origin marker identifies the origin of the part, which is used when 
moving, rotating, or otherwise positioning the part in PADS Layout. The 
decal origin is also referenced by automatic assembly and pick-and-place 
machines. 

Creating a PCB Decal 
 

In the following exercise you will create a PCB decal for the 26-pin connector, 
shown below, by adding new terminals, a component outline, and assigning 
pad stacks. 
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Add a terminal 

The first step in defining a PCB decal is to add a terminal for each pin of the 
part. Each terminal is sequentially numbered as it's added to the decal. Each 
terminal number is its pin number, for example, terminal 1 is pin number 1, 
terminal 2 is pin number 2, and so on. 

1. Drafting button  > Terminal button  . 
When the Add Terminals dialog box opens, accept the defaults and click OK. 
You are now in add terminal mode. Each click of the mouse button will add a 
new terminal at the location of the click. 

2. Set the design grid to 50 by typing g50 and pressing Enter. 
3. Set the display grid to 50 by typing gd50 and pressing Enter. 
4. Move the pointer over the decal origin marker and click to add the first 

terminal at the decal origin. 
5. Move the pointer to location X50,Y50 (using the X,Y location display on the 

Status Bar as a guide) and click to add the second terminal. 

Add multiple terminals using Step and Repeat 

You can use the Step and Repeat command to quickly replicate objects, such as 
terminals, in a repetitive pattern. 

1. Select button  . 
2. Right-click and click Select Terminals. 
3. Click the first terminal. 
4. Ctrl+click to add the second terminal to the selection. 
5. Right-click and click Step and Repeat.  
6. In the Step and Repeat dialog box, click the Linear tab.  

Tip: The Radial Placement licensing option enables Polar and Radial 
placement tabs. 

7. Click Right as the Direction, set the Count to 12, the Distance to 100, and 
then click OK.  
Result: Twenty-four new terminals are automatically added to complete the 
connector pin pattern. 

Assign pad shape and size 

The next step in defining a decal is to assign pad shape and size. This is 
performed in the pad stack editor. 
1. Setup menu > Pad Stacks. 
2. Select <Mounted Side> from the Shape: Size: Layer list. 
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Tip: Mounted Side is the side of the printed circuit board, front or back, on 
which components are mounted. 

3. In the Parameters area, click the Circular pad shape button.  
4. Also in the Parameters area, change the diameter of the pad by typing 55 in 

the Diameter box. 
5. In the Drill Size box, type 28. 
6. To change the pad shape and size for the remaining layers, select <Inner 

Layers> and <Opposite Side> from the Shape: Size: Layer list, and set the 
pad diameter for each to 55. 
Tip: Inner Layers are design layers other than those on the top or bottom of a 
printed circuit board. Inner layers may be routing layers, plane layers, or a 
combination of both. Opposite Side is the outer layer of the printed circuit 
board opposite the Mounted side layer. 

7. Click OK. 
Tip: If the drill holes are not visible, type do and press Enter. The do modeless 
command toggles the drill outline display setting. 

Create a component outline 

Create part outlines with the 2D line drawing tool. 

1. 2D Line button  . 
2. Right-click and click Rectangle. 
3. Position the pointer at the upper left corner of the outline by typing 

s -100 100 (s, negative 100, space, 100) and pressing Enter. 
4. Without moving the pointer, press the Spacebar to initiate a new rectangular 

polygon. 
5. Move the pointer to location X1350,Y -50.  
6. Click to complete the polygon. 

Adding keepouts to a PCB decal 
 

In PADS Layout, you have the capability to define a region as a keepout for vias, 
traces, and other design objects. You can define keepouts on the PCB or within 
the PCB decal. 
In this exercise you will define a via keepout for the connector. 

1. Keepout button . 
2. Right-click and click Rectangle.  
3. Position the pointer at the upper left corner of the outline and click to begin 

drawing the keepout rectangle. 
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4. Move the pointer over the lower right corner of the outline and click to 
complete the polygon. 

5. In the Add Drafting dialog box, in the Restrictions area select the Via and 
Jumper check box to assign the restrictions for the keepout. 

6. In the layer list click <All Layers> to assign the keepout to all layers. 
7. Click OK to complete the definition of the keepout. 

Assigning PCB decal attributes 
 

In PADS Layout you assign attributes; such as a manufacturer's part number, 
corporate part number, height, and other component specific information to 
components or part types. You can also assign attributes to PCB decals. 

Add a height attribute 

1. Edit menu > Attribute Manager. 
2. If the Geometry.Height attribute is not already in the list: 

a) In the Decal Attributes dialog box, click Browse Lib. Attr. 
b) In the Browse Library Attributes dialog box, click Refresh to update 

the attribute listing to view all attributes used in the library. 
c) In the Attribute list click Geometry.Height, and click OK to add the 

height attribute to the decal. 
3. Double-click in the Value box, and type 300 (in current-unit mils for .300”). 
4. Click Close. 

Adding attribute labels to a PCB decal 
 

You display attributes in the design as text labels. You can also add additional 
labels to accommodate different size and location requirements for reference 
designators. The visibility and position of each label is managed within the 
Layout Editor. 
You can predefine locations for attribute labels by adding placeholder labels in 
the PCB decal. The placeholders act as the defaults for new labels added or made 
visible in the Layout Editor. 

Add a reference designator label to the decal 

In this exercise, you will add an assembly drawing reference designator label to 
the connector decal. Labels are added to the PCB decal using the Add New 
Label command. 

1. Add New Label button . 
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Result: After you click the Add New Label button, a new label appears just 
below the current Name label and the Add New Decal Label dialog box 
appears. 

2. In the Attribute list, click Ref. Des. to assign the new label as the placeholder 
for an additional reference designator label. 

3. In the Show list, click Value, enabling the display of only the value of 
the attribute. 

4. Change the position of the label by typing 600 in the X box and 150 in  
the Y box. In the horizontal and vertical Justification lists click Center 
and Center.  

5. In the Layer list, click Assembly Drawing Top to assign the text to the top 
assembly layer. 

6. Click OK to close the dialog box and complete the addition of the label. 
Tip: The new label will not appear if a color is not assigned for objects on the 
Assembly Drawing Top layer in the Display Colors Setup dialog box.  
Exception: Reference designator colors are controlled by the Pin Num. label 
option instead of Attributes. Part type colors are controlled by the Type label 
option instead of Attributes. 

Position the other labels 

Position the Name and Type labels in the decal where the text will not be 
obscured when visible. 

1. Select button . 
2. With nothing selected, right-click and click Select Text/Drafting. 
3. Select each label and to move it press Ctrl+E.  
4. Place them in the approximate location shown in the "Creating a PCB Decal" 

section at the beginning of the tutorial.  
5. Click to complete the moves. 

Save the PCB decal 

You created your first PCB decal in PADS Layout. Save it to the library. 

1. Save button . 
2. In the Save PCB Decal to Library dialog box, click the …\preview library. 
3. In the Name of PCB Decal box, type 26pinconn.  
4. Click OK and confirm messages that may appear asking if you want to 

overwrite the file. 
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Creating a new part type 
 

Now that you've completed the PCB decals required for the tutorial, you will 
create a part type for the new 26-pin connector using the part type editor. 

Assign general parameters 

The first steps in creating connector part types are establishing the part type as 
a connector and assigning a PCB decal. 
1. File menu > Library. 
2. To create a new part type in the preview library, click …\preview in the 

Library list. 
3. Click the Parts button. 
4. Click New. 
5. In the Part Information for Part dialog box, click the General tab. 
6. In the Logic Family list, scroll and select the CON family type, which 

establishes the default reference designator prefix J for this part type. 
7. To establish the part type as a connector, in the Options area, select the 

Special Purpose check box, and click Connector. 

Assign a PCB decal 

The next step is to assign a PCB decal for the part type. 
1. PCB Decals tab. 
2. In the Library list, click the …\preview library. 
3. In the Filter box, type 26p* and click Apply. 
4. In the Unassigned Decals list, click the 26PINCONN decal. 
5. Click Assign to move the decal into the Assigned Decals list. 

Add part type attributes 

You can add attribute labels in the PCB decal. For part types, you add attributes 
and their respective values. Enter attributes directly into the attribute cell or 
click one from a list of all attributes in the PADS library. 
For this exercise, you will add attributes to the connector part type from those 
attributes found in the library. 
1. Attributes tab. 
2. Click Add. 
3. Click Browse Lib. Attr. 
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4. In the Browse Library Attributes dialog box, click the Description attribute 
and click OK. 

5. Double-click in the Value cell. 
6. Type CONNECTOR, RIBBON, 26 PIN in the Value cell. 
7. Click Add again, and repeat the previous steps to add these attributes 

and values: 
Attributes Values 
Cost (leave blank) 
Part Number MGEG26R 
Manufacturer #1 ACME 
Manufacturer #2 (leave blank) 

 

Assign CAE decals 

Now assign Logic decals for the part type. 
1. Connector tab. 
2. Click Add. 
3. Click the Browse button from the Special Symbol cell. 
4. In the Browse for Special Symbols dialog box, select the EXTIN symbol in the 

…\misc library, and click OK. 
5. Double-click in the Pin Type cell. 
6. In the list click Source to assign input pins as sources. 
7. Click Add again, and click the Browse button from the newly added Special 

Symbol cell. 
8. In the Browse for Special Symbols dialog box, select the EXTOUT symbol in 

the …\misc library, and click OK. 
9. Double-click in the Pin Type cell. 
10. In the list, click Load. 

Save the part type 

Now that the part type definition is complete, save the new part type. 
1. Click OK. 
2. In the Save Part Type to Library dialog box, navigate to the …\preview 

library, name the part type 26pinconn, and click OK. Confirm any messages 
that appear asking if you want to overwrite the file. 

3. In the Library Manager dialog box, click Close.  
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Creating PCB decals using the Decal wizard 
 

The PCB Decal Editor provides dialog box-driven PCB decal wizards. These 
wizards provide automated tools for creating standard footprint patterns 
automatically.  

Create a SOIC decal 

Now that you've experienced PCB decal creation 
using the interactive tools in the PCB Decal Editor, 
you will create the SO28 PCB decal, shown at right, 
using the automated tools in the PCB Decal Editor. 

 

1. On the Drafting Toolbar, Wizard button . 
2. In the Decal Wizard dialog box, click the Dual tab. 
3. In the Decal area, in the Device type section, click SMD. 
4.  In the Orientation section, click Horizontal. 
5. In the Pins area, enter the following: 

a. Pin count box, type 28 
b. Width box, type 24 
c. Length box, type, 90 
d. Pin pitch box, type 50 

7. In the Row Pitch area, click Center to Center and in the Value box, type 450. 
8. In both the Pin 1 shape and Pin shape sections, click Oval. 
9. In the Placement outline area, in the width box type 600, and in the Height 

box type 800. 
10. In the Thermal pad area, clear the Create check box. 
11. Click OK. The PCB decal is automatically created. 

Result: You just created a 28-pin SOIC in a few easy steps.  

To return to the Layout Editor:  

 On the File menu, click Exit Decal Editor. 
Do not save a copy of the design. 

You completed the part creation tutorial. 



Preparing a Design 16 

Preparing a Design 

Preparing a design involves the establishment of the layer arrangement, setting 
display colors, defining a board outline and a few other activities. 

In this lesson: 

 Establishing a layer arrangement for the PCB 
 Setting display colors 
 Saving a Start-up file 
 Creating a board outline 
 Modifying the board outline 
 Adding non-electrical objects 

Restriction 

 This tutorial requires the Drafting Editing, ECO, and General Editing  
licensing options.  

To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout. Make sure you are starting with 
a blank screen, or new design. 

Establishing a layer arrangement for the PCB 
 

PADS Layout enables you to define layer arrangements for the PCB including 
the number of layers, the nets associated with embedded plane layers, layer 
stackup, and layer thickness. 
The tutorial design is a four-layer PCB with two internal plane layers supporting 
multiple plane nets. In this section you will define the layer arrangement for the 
tutorial design using the layer definition tools of PADS Layout. 

Increase the number of layers 

The default design is a two-layer PCB.  
1. Setup menu > Layer Definition 
2. In the Layers Setup dialog box, in the Electrical Layers area click Modify. 
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3. In the Modify Electrical Layer Count dialog box, in the Enter new number of 
electrical layers box type 4 to increase the number of layers from 2 to 4. 

4. Click OK. 
5. In the Reassign Electrical Layers dialog box, accept the default reassignment 

of layer 1 to layer 1 and layer 2 to layer 4 and click OK. 

Set the layer arrangement and names 

Once you set the correct number of layers, assign the layer types for each layer 
and enter layer names. 

The first layer: 

1. In the Layers Setup dialog box, select Top in the list of layers.  
2. In the Name box, type Primary Component Side. 
3. In the Electrical Layer Type area, click the Component layer type. 
4. In the Plane Type area, click No Plane. 
5. Set the Routing Direction to Vertical. 

The second layer: 

1. Select the second layer, Inner Layer 2, and name it Ground Plane.  
2. Change the Plane Type to CAM Plane. 
3. Set the Routing Direction to Any. 

The third layer: 

1. Select the third layer, Inner Layer 3, and name it Power Plane.  
2. Change the Plane Type to Split/Mixed (plane).  
3. Set the Routing Direction to Any. 

The last layer: 

1. Select the fourth layer, Bottom, and name it Secondary Component Side. 
2. In the Electrical Layer Type area, click a Component layer type.  
3. In the Plane Type area, click No Plane. 
4. Set the Routing Direction to Horizontal. 

Set layer stackup 

A typical layer stackup for a four-layer PCB is composed of a pair of copper clad 
fiberglass substrates, with an insulator/bonding material in between. The 
insulator/bonding material is typically a resin sheet that bonds the substrate 
pairs together when a multi-layered board is manufactured. This bonding 
material is also known as Prepreg. 
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Layer stackup: 

 
Use the Layer Thickness dialog box to set the layer stackup values. 
1. In the Layers Setup dialog box, click Thickness. 
2. In the Layer Thickness dialog box, for the Copper Thickness Units click 

Weight (oz). 
3. In the Layer list, click Primary Component Side. 
4. Double-click in the Thickness box for Primary Component Side and type 2 to 

reflect that it has a copper weight of 2 ounces  
Tip: 1 oz. of copper weight = .00135" of copper thickness. 

5. In the Layer list, click Ground Plane. 
6. Double-click in the Thickness box for Ground Plane and type 1 to reflect that 

it has a copper weight of 1 ounce. 
7. In the Layer list, click Power Plane. 
8. Double-click in the Thickness box for Power Plane and type 1 to reflect that it 

has a copper weight of 1 ounce. 
9. In the Layer list, click Secondary Component Side. 
10. Double-click in the Thickness box for Secondary Component Side and 

type 2 to reflect that it has a copper weight of 2 ounces. 
11. Double-click in the Substrate box between Ground Plane and 

Power Plane and click Prepreg to establish this level as the insulator/bonding 
layer. 

12. Double-click in the Thickness box for the Prepreg layer and type 35. 
Tip: The Dielectric Constant values listed are values given for manufacturing 
materials such as FR-4 to describe electrical characteristics. 

13. Click OK twice. 

Setting the grids 

To establish a working grid for your design, use the grid modeless commands. 
1. To set all grids to 100 mils, type g100 and press Enter. 
2. To set the Display Grid to 200, type gd200 and press Enter. 
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Setting display colors 
 

The Display Colors Setup dialog box assigns or changes layer colors and makes 
individual items visible or invisible. You can also set the color for the screen 
background, board outline, and other elements here. 

Assign new colors to the new layers 

The increase in the number of layers requires additional color assignments. 
1. Setup menu > Display Colors 
2. In the Display Colors Setup dialog box, in the Layers/Object Types area, click 

the number 2 to select the row associated with the Ground Plane layer. 
3. In the Selected Color area, click the light-brown tile. All objects on the layer 

assume the light-brown color. 
Tip: A square highlight indicates the active color. 

4. Repeat steps 2 and 3 for the Power Plane layer, using light green for 
all objects. 

Make objects invisible 

To hide objects, assign them the same color as the design background. 
1. Click the black tile (the same as the background color) in the Selected 

Color area. 
2. In the Other area, click Connection to make connections invisible.  

Tip: Connections are the unrouted connection lines, often called ratsnest or 
airlines. 

3. In the Type column, clear the check box to make part type names invisible on 
all layers. 

4. For the Ref. Des., Top, and Bottom columns click the tiles for both the 
Ground Plane and Power Plane layers since no reference designators, or 
component outlines appear on those layers. 

Set colors for other objects 

1. Click Errors to select the column for all layers and click the white tile to set 
the Errors for Primary Component Side to white. 

2. Click the purple tile. In the Ref. Des. column click the tile for the Secondary 
Component Side. 

3. With purple as the selected color, in the Bottom column, click the tile for the 
Secondary Component Side. 

4. Click the light-gray tile. In the Top column, click the tile for the Primary 
Component Side layer. 
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5. Click the yellow tile. In the Keepouts column, click the tile for the Primary 
Component Side layer. 

6. Click OK. 

Saving color arrangements 

You can save color arrangements to reuse them from design to design. The Save 
option in the Display Colors interface allows saving of color configurations. The 
list can then be toggled to activate and apply the color changes. 

Saving a Start-up file 
 

Start-up files are a method of reusing design options from one design to another. 
A start-up file contains predefined system settings such as the number of layers, 
display color assignments, current working grids, design rules, and many other 
commonly used options. You can create start-up files for a particular board type, 
such as a two layer or four layer PCB. You can then use the start-up file for each 
PCB design and avoid entering standard options with every new design. 
Each time you start PADS Layout, the last start-up file used automatically 
opens. Each time you click New on the File menu, however, the Set Start Up File 
dialog box appears so you can choose a start-up file. 

Saving a start-up file 

Now that you established options for your design, you can save them in a start-
up file for use with your next four-layer design. 
1. File menu > Save As Start-up File 
2. In the Save As Start-up File dialog box, type preview in the File name box, 

and then click Save. 
2. In the Start-up File Output dialog box, type PADS Layout Tutorial in the 

Startup File Description box, leave the CAM section check box cleared, and 
click OK. 

The current system settings are saved to the preview.stp file in the  
C:\Mentor Graphics\<latest_release>\SDD_HOME\Settings folder. 



Preparing a Design 21 

Creating a board outline 
 

A board outline is created using polygon creation methods similar to those 
for creating drafting items such as part outlines, copper areas, and copper 
pour areas. 

1. Drafting Toolbar button  > Board Outline and Cut Out button  
2. Right-click and click Rectangle.  
3. Move the pointer to location X200,Y1900 and click to add the first corner of 

the board outline. A dynamic line attaches to the pointer. 
4. Use the search modeless command to place the pointer at a specified location. 

Type s 3000 300 (including spaces) and press Enter. 
5. Press the Spacebar to complete the rectangle. 

Modifying the board outline 
 

The next procedure modifies a section of the board outline by changing one of the 
existing straight lines into an arc. Before you modify the board outline, you must 
adjust the Selection Filter to define the types of objects you can select. 
1. Right-click and click Select Board Outline to enable selection of board outline 

elements.  
2. Click the vertical line on the right side of the board outline to select it. 
3. Right-click and click Pull Arc. 
4. Move the pointer to the right, pulling the arc away from the board, to location 

X3800,Y1100.  
5. Click to place the arc.  

Tip: If you accidentally place the arc in the wrong location, repeat Steps 2 
through 5. 

6. With the arc still selected, right-click and click Select Shape to select the 
entire board outline. 

7. Right-click and click Add Miters. 
8. In the Add Miters dialog box, type 35 in the Radius box and click OK.  

Result: All 90-degree corners of the PCB are globally mitered at the 
specified value. 

9. On the standard toolbar, click the Board button to fit the board outline to the 
screen.  
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Adding non-electrical objects 
 

This tutorial design has a requirement for a metal shield that covers an area 
mostly around the center of the board. The shield is mounted on the bottom of 
the PCB, protrudes through a slot and covers an area on the top of the PCB. The 
shield is fastened to the PCB using two small screws. 

 
Managing the shield in PADS Layout requires the creation of a slot (or board 
cutout) and a keepout area. In addition, it requires the addition of a component 
with drilled holes and a keepout to represent the shield in the design. 

Creating the board cutout 

You create a board cutout using the board outline and cut out command. One 
board outline is allowed per design. Since a board outline is already present, 
PADS Layout assumes the next use of the board outline and cut out command is 
for the creation of a board cutout. 

1. Drafting Toolbar > Board Outline and Cut Out button  
2. Click OK to confirm creation of a cut out, and continue the operation.  
3. Right-click and click Rectangle.  
4. Move the pointer to location X2400,Y1700 and click to begin the rectangle. 
5. Move the pointer to X2500,Y500 and click to complete the board cutout. 
To complete the definition of the cutout you must convert the ends to arcs. 
1. To change the working grid, type g50 and press Enter. 
2. Select one of the short horizontal segments of the cutout, right-click, and click 

Pull Arc.  
3. Create a 180 degree arc at the end.  

Tip: The Status Bar contains the radius and arc degree display in the section 
normally reserved for the grid setting. 
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4. Repeat Steps 2 and 3 for the other end segment of the cutout. 

Create a height keepout 

You can define a region as a keepout for vias, traces, and other design objects. 
You can define keepouts on the PCB or within a PCB decal.  
In this exercise, you define a height keepout for the PCB under the area covered 
by the shield. 

1. Drafting Toolbar > Keepout button  
2. Right-click and click Rectangle.  
3. Position the pointer at the upper left corner of the board cutout (at 

X2400,Y1700) and click to begin the keepout rectangle. 
4. Move the pointer towards the lower left corner of the board (at X600,Y500) 

and click to complete the keepout. 
5. In the Add Drafting dialog box, in the Restrictions area select the Placement 

check box to assign the keepout as a placement keepout. 
6. Select the Component height check box, and type 100 in the value box to keep 

all components with a height attribute greater than 100 out of the keepout 
area. 

7. In the Layer list, click Primary Component Side, to assign the keepout to the 
top layer only. 

8. Click OK. 

Adding the mounting hole component 

Mounting holes are added to a design as a component. For the tutorial, the 
mounting hole component was previously created for you. You only need to add 
the component to the design using the ECO commands. 

1. ECO Toolbar button  
2. In the ECO Options dialog box, clear the Write ECO File check box in the 

ECO File area, and then click OK.  
3. On the ECO toolbar, click the Add Component button. 
4. In the Get Part Type from Library dialog box, click the …\preview library in 

the Filter area. 
5. In the Items area, type sh* and click Apply. The SHIELD part type appears 

in the Part Types list. 
6. Select the SHIELD part type and click Add to add the shield component to 

the design.  
Result: The part is added to the design and attached to the pointer. 

7. With the part attached to the pointer, click Close to close the Get Part Type 
from Library dialog box. 
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8. Move the shield component to X2600,Y600, and click to place it. 
9. Click the ECO Toolbar button again to exit ECO mode and adding 

components. 

Glue the mounting hole component 

Glue a component to prevent it from being moved inadvertently. 
1. With nothing selected, right-click and click Select Components. 
2.  Click the SHIELD mounting holes component X1. 
3. Right-click and click Properties. 
4. In the Component Properties dialog box, select the Glued check box to assign 

it as a glued component. 
5. Click OK. 
6. Do not save a copy of the design. 

You completed the design preparation tutorial. 
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Importing Design Data 

You can import design data into PADS Layout from many external sources. The 
most common method of passing design data into PADS Layout is importing a 
PADS formatted ASCII file. It’s the method used to import data from schematic 
capture products like PADS Logic or DxDesigner. 

In this lesson: 

 Importing a netlist from an ASCII file 
 Assigning nets to the plane layers 

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewbrd.pcb found in the \PADS Projects\Samples folder. 

Importing a netlist from an ASCII file 
 

A netlist typically contains a list of all parts used on the PCB and the nets that 
interconnect the parts. 
Tip: These are the typical steps used to import a PADS Layout netlist exported 
from PADS Logic. When netlists are exported from DxDesigner, the PADS 
Layout netlist file (with an *.asc file extension) is located in the DxDesigner 
project directory. 

Import the file 

1. File menu > Import. 
2. Navigate to the Samples folder and click the file named previewnet.asc.  
3. Click Open. After the import process completes, components are placed at the 

design origin, ready for placement. 
4. On the View menu, click Extents to see all of the parts placed at the 

design origin. 

Assigning nets to the plane layers 
 

Now that you added nets to the design, you can associate the plane layers to 
their respective nets. Do this using the Layers Setup dialog box. 
1. Setup menu > Layer Definition. 
2. In the Layers Setup dialog box, select the Ground Plane layer from the 

Layers list, and click Assign Nets.  



Importing Design Data 26 

3. In the Plane Layer Nets dialog box, scroll through the All Nets list, select 
GND from the All Nets list, and then click Add to move it to the Assigned 
Nets list. 

4. Click OK to assign the GND net with the Ground Plane layer. 
5. In the Layers list, select the Power Plane layer and then click Assign Nets.  
6. In the Plane Layer Nets dialog box, in the All Nets list select +5V. Ctrl+click 

to also select +12V from the All Nets list.  
7. Click Add to move the nets to the Assigned Nets list. 
8. Click OK to assign the +5V and +12V nets with the Power Plane layer. 
9. In the Layers Setup dialog box, click OK. 
10. Do not save a copy of the design. 

You completed the importing design data tutorial. 
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Importing Schematic Data 

The DxDesigner Link is a multi-purpose tool primarily used for passing data 
between DxDesigner and PADS Layout. It also provides features for cross-
selection between the products (known as cross-probing). 
Using the DxDesigner Link in PADS Layout you will process a DxDesigner 
schematic and pass part, net, and constraint data directly to PADS Layout to 
start a design. Using the cross-probing features, you will perform schematic 
driven placement. You will also update a schematic with changes made in PADS 
Layout. 

In this lesson: 

 Updating a PCB design with schematic data 
 Schematic driven placement 
 Updating a schematic with PCB data 

Requirements 

 This tutorial requires that you install both DxDesigner and PADS Layout on 
your system. 

 This tutorial requires the General Editing and ECO licensing options. To 
determine whether you can proceed, on the Help menu, click Installed 
Options.  

Preparation 

If it is not already running, start DxDesigner and open the Preview.prj tutorial 
project found in the \PADS Projects\Samples\Preview folder. Open page 1 of 
the Preview schematic. 
If it is not already running, start PADS Layout and open the file named 
previewbrd.pcb found in the \PADS Projects\Samples folder. 

Resizing the view 

To get the greatest benefit of this tutorial, it is recommended you re-size the 
applications to each use half of your desktop. 

Establish communication links 

The DxDesigner link streamlines the passing of data and communication 
between DxDesigner and PADS Layout and is the preferred method for 
synchronizing schematic and PCB design databases. 
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An additional benefit of the DxDesigner link is inter-tool communication. Use 
this automation technology to cross-probe between linked applications. Cross-
probing is having selections of nets, components, or pins made in one application 
result in the selection of the corresponding object in the linked application. 
To enable inter-tool communication, you start the DxDesigner link and connect 
with a current or new session of DxDesigner. 

To connect DxDesigner: 

1. PADS Layout Tools menu > DxDesigner 
2.  In the DxDesigner Link, click the Documents tab. 
3. In the DxDesigner Project File area, verify the project is set to preview.prj 

and then click Connect to establish a communication link. 
Tips:  
 When the link is established, the Connect button changes to Disconnect. Use 

Disconnect to break the communication link.  
 Upon connection with DxDesigner, two new tabs appear in the dialog box: 

Selection and Placement. These tabs are discussed later in this tutorial. 

Updating a PCB design with schematic data 
 

Creating a netlist is the basic method for passing schematic data into PADS 
Layout to start the PCB design process. A netlist contains a list of the parts, 
their part types, and all of their net connections. 
Use the DxDesigner Link to automatically generate and send a netlist to PADS 
Layout. 

Send a netlist to PADS Layout 

1. In the DxDesigner Link, click Forward to PCB. 
2. In the Forward Annotation dialog box, click Update PCB. 
3. In the Data to Pass area, select all three options to update parts, netlist, 

attributes, design rules, and library parts. 
4. Clear the Pause before updating design check box and click OK to start the 

process.  
Result: The Process indicator appears and is updated at the completion of 
each step in the process. After the process completes, all the components are 
positioned at the design origin, ready for placement. 

5. Click the Show Report button in the progress indicator to view a status 
report generated by each process. 

6. Click Close to close the Process indicator dialog box. 
Requirement: Do not close the DxDesigner Link dialog box. 
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Schematic driven placement 
 

Now that you have a PADS Layout design with the parts and nets from the 
schematic, you will prepare the parts for placement. You will use cross-probing to 
perform schematic-driven placement. You begin by placing PADS Layout in 
Move mode so part selections made in PADS Logic result in movement of the 
selected part. 

Set auto-panning mode 

The DxDesigner link provides options for automatic panning and zooming to 
selected objects. For the purpose of this tutorial, you will disable the automatic 
zooming and panning. 
1. In the DxDesigner Link, click the Selection tab. 
2. In the Selection Passing area, set the PADS Layout zoom mode to None. 

Establish a working and design grid 

1. In PADS Layout, set the design grid to 50 mils by typing g50 and pressing 
Enter. 

2. Set the display grid to 50 mils by typing gd50 and pressing Enter.  
Tip: The display grid may not be visible until you zoom in. 

Disperse the components 

Use the Disperse command to distribute the components around the outside of 
the board outline. 
1. In PADS Layout, on the Tools menu, click Disperse Components and then 

click Yes to confirm the dispersion. 
2. Click the Board button to fit the view to the board outline. 

Enable the Move Component verb mode 

1. In PADS Layout, click the Design Toolbar button. 
 

2. On the Design toolbar, click the Move button to place PADS Layout into 
Move (Component) mode. 

Make a selection in the schematic 

1. In DxDesigner, click any pin of the J1 connector on the left side of the 
schematic.  
Result: J1 is selected in PADS Layout. 

2. Move your pointer to the PADS Layout window; you are now moving J1 in 
PADS Layout. 
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Place the part 

Place the component on the opposite side of the board at a specific location using 
the part placement commands of PADS Layout. 
1. In PADS Layout Right-click and click Flip Side to flip the part to the opposite 

side of the PCB. 
2. Using the grid coordinate readout on the PADS Layout status bar as a guide, 

click to place JI at X1650, Y400. 

Updating a schematic with PCB data 
 

You can update a schematic with changes made in PADS Layout using the 
Backward from PCB button. This process compiles a netlist from the PCB 
database and a PADS Layout ECO file and updates the schematic. 
For this tutorial, you will open a PCB design, rename all of the components, and 
pass the updates back to the schematic. 

Open the PCB design and re-establish the communication link 

1. In the Documents tab of the DxDesigner Link, in the PADS Layout Design 
area, click Disconnect. 

2. Click Browse. 
3. In the File Open dialog box, select the previewplaced.pcb file and 

click Open. 
4. In the PADS Layout Design area, click Connect to connect PADS Layout to 

DxDesigner once again. 
Tip: Do not save any changes in the current file if prompted to do so. 

Rename the parts 

Rename components using the ECO commands of PADS Layout. The ECO 
commands are a collection of editing tools for changing a PCB design database 
and include add and delete part, add and delete net, and other editing 
commands. Access the ECO commands from the ECO toolbar in PADS Layout. 
1. ECO Toolbar button. 

Tip: If the ECO Options dialog box does not appear, click the Options button 
on the ECO toolbar. 

2. In the ECO Options dialog box, select the Write ECO file check box in the 
ECO file area. 

3. Select the Write ECO file after closing toolbar check box. 
4. Leave all other settings and options as they appear and click OK. 
5. On the ECO toolbar, click the Auto Renumber button. 
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6. In the AutoRenumber dialog box, accept the default settings, and click OK to 
rename all of the parts on the design. 

7. Click the ECO Toolbar button again to close the toolbar and to write the 
changes to the ECO file. 

Update the schematic 

Update the schematic using the Backward from PCB operation. 
1. In the DxDesigner Link dialog box, click the Backward from PCB button. 
2. In the Backward Annotation dialog box, click Use Existing ECO file in the 

ECO preference area. 
3. In the Data to Pass to Schematic area, select all options to update parts, 

netlist, attributes, and design rules. 
4. Clear Pause before updating schematic and click OK to start the process. The 

Process indicator appears and is updated at the completion of each step in the 
process. 
Tip: If a warning appears regarding Rule changes, click Yes. 

5. When the process completes, click the Show report buttons in the progress 
indicator to view a status report generated by each process. 

6. Click Close to close the indicator dialog box. 
7. Do not save a copy of the design. 

You completed the DxDesigner link tutorial. 
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Assigning Constraints 

Assigning constraints to your design allows you to easily control and verify 
critical design areas. Constraint types include clearance, routing, and high-speed 
rules that can be assigned to nets, layers, classes (collection of nets), groups 
(collection of pin pairs), or individual pin pairs. You can also assign a default set 
of design rules that apply to all objects not having a unique rule. 

In this lesson: 

 Setting default clearance rules 
 Setting net clearance rules 
 Setting conditional rules 

Restriction 

This tutorial requires the Advanced Rules (for the Conditional Rules section) and 
General Editing licensing options.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewnet.pcb found in the \PADS Projects\Samples folder. 

Setting Default Clearance Rules 
 

You can define clearance, routing, and high-speed rules for each level of the 
design rule hierarchy. 
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Setting default clearance rules 

The Clearance area of the Clearance Rules dialog box contains a matrix of PCB 
design data. You can specify values for each or all data types in the matrix. 
1. Setup menu > Design Rules > Default button.  
2.  Clearance button.  
3. Click All (in the upper-left corner of the Clearance matrix) to set a global 

default clearance value. 
4. In the Input Clearance Value dialog box, type 8 and click OK. 
5. In the Trace Width area, type 6 in the Minimum box, type 8 in the 

Recommended box, and type 12 in the Maximum box. 
6. Type 12 in the Same Net and Other clearance text boxes, with the exception 

of Trace to Crn box. Set this box to 0. 
7. Click OK. 

Set default routing rules 

To avoid routing on the plane layers, remove them from the Selected routing 
layers as defined in the routing rules. The Layer Biasing area of the Routing 
Rules dialog box contains a list of selected routing layers. This list lets you 
specify which layers are permitted for routing. 
1. Routing button. 
2. In the Layer biasing area, in the Selected Layers list, select the Ground 

Plane, press and hold Ctrl and click Power Plane to add them to the selection.  
3. Click Remove to prevent routing on the plane layers. 
4. Click OK to close the Routing Rules dialog box. 
5. Click Close to close the Default Rules dialog box. 

Setting net clearance rules 
 

You can assign net-specific clearances that take precedence over the default 
rules previously entered. 
1. Net button. 
2. Scroll through the Nets list. Ctrl+click to select +5V, +12V, and GND. The 

three selected nets appear beside Selected, under the rule type buttons. 
3. Click the Clearance button to set the same clearance rules for all three nets. 
4. In the Clearance Rules dialog box, click All (in the upper-left corner of the 

matrix) to set a global clearance value. 
5. In the Input Clearance Value dialog box, type 10 as the global clearance and 

then click OK. 
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6. In the Trace Width area, type 10 in the Minimum box, type 12 in the 
Recommended box, and type 15 in the Maximum box. 

7. To complete the definition, click OK in the Clearance Rules dialog box. 
8. Click Close to close the Net Rules dialog box. 
See also: PADS Layout Help for details about defining other Hierarchy rules. 

Setting conditional rules 
 

When two nets require a specific clearance between each other (to avoid adverse 
effects on the circuitry), you must define a conditional rule. An example of a 
conditional rule might be the Underwriters Laboratories (UL) requirements of 
segregating primary, secondary, and ground nets when alternating current is 
directly connected to the PCB. You can assign conditional rules between most 
components of the design rule hierarchy. Conditional rules can exist between 
nets, nets and classes, classes and pin pairs, nets on a specific layer, and so on. 

To assign a net-to-net conditional rule: 

1. Conditional Rules button. 
2. In the Source Rule Object area, click Nets. 

Result: A list of nets appears in the Source Rule Object list. 
3. Select net +5V. 
4. In the Against Rule Object area, click Nets.  

Result: A list of nets appears in the Against Rule Object list. 
5. Select net +12V. 
6. Click Create to define the conditional rule. The new rule appears in the 

Existing Rule Sets area. 
7. In the Current Rule Set area, type 25 in the Object to Object box. 
8. Close all of the open dialog boxes. 

Result: The rule you just created will keep all objects pertaining to the +5V 
and +12V nets 25 mils apart. 

9. Do not save a copy of the design. 

You completed the design rules tutorial. 
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Moving and Placing Components  

PADS Layout offers several methods for placing components. 

In this lesson: 

 Pre-placement procedures 
 Placing components using Move 
 Placing components using Find 
 Placing components using Move Sequential 
 Placing components using Properties 
 Experimenting with the placement tools 

Restriction 

This tutorial requires the General Editing licensing option.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewrules.pcb in the \PADS Projects\Samples folder.  

Preplacement procedures 
 

You must complete several procedures before you begin placing parts. 

Setting a placement grid 

1. To set the design grid to 50 mils, type g50 and press Enter. 
2. To set the display grid to 50 mils, type gd50 and press Enter. The display grid 

may not be visible. If you want to see it, just zoom in. 



Moving and Placing Components 36 

Dispersing the components 

Disperse the components around the board outline to make them all visible. 
1. Tools menu > Disperse Components. 
2. Click Yes to confirm the dispersion. 
3. On the View menu, click Extents to fit the board and all the components in 

view. 

Setting the net colors 

To aid in the placement and correct orientation of decoupling capacitors, assign a 
color to the +5V net. 
1. View menu > Nets. 
2. In the View Nets dialog box, select +5V in the Net list. 
3. Click Add to add +5V to the View list. 
4. In the View list, select +5V. 
5. Click dark gray to display all component pins and vias connected to +5V as 

dark gray. 

Setting the net visibility 

Temporarily make the plane nets invisible to help determine the best location for 
components. 
1. With the +5V net still selected, clear the Traces Plus the Following Unroutes 

check box to make the net invisible. 
2. In the Net list, select both the +12V and GND nets. 
3. Click Add to move them to the View List. 
4. In the View list, select both the +12V and GND nets, and clear the Traces 

Plus the Following Unroutes check box to make them invisible. 
5. Click OK to apply the visibility settings and close the View Nets dialog box. 

Placing components using Move 
 

In this section you will learn how to use the Move command to place components 
for the tutorial design. The component positions are established to efficiently use 
your time with the tutorial. 
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Placement preview: 

 

Placing the ICs 

Place the ICs and their associated decoupling capacitors. 
1. Design Toolbar button. 
2. Move button. 
3. Type the modeless command ssu1 and press Enter to search and select U1. 

U1 attaches to the pointer and all of the nets connected to U1 appear. 
4. Position U1 at X1400,Y800 and click to place it. 
5. Type the modeless command ssu2 and press Enter to search and select U2.  
6. With U2 attached to the pointer, move U2 left to right across the board 

horizontally and note how the nets reconnect as U2 moves. This is called 
dynamic reconnect and is useful when placing components. 

7. Type the modeless command s1400 1450 to position U2 at X1400,Y1450 and 
press the Spacebar to place it. 

8. Use Move to complete the placement of the following components at their 
respective locations: 
Component Move to 
U3 2050 800 
U4 2050 1450 
U5 750 1600 
U6 750 1250 
U7 650 800 

Placing the decoupling capacitors 

Use the operations described in the above procedure and place the decoupling 
capacitors. 
1. Type the modeless command ssc1 and press Enter to search and select C1. 
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Result: C1 attaches to the pointer, but its nets do not appear because the +5V 
and GND nets are invisible. 

2. To place C1 on the opposite side of the board, right-click and click Flip Side. 
3. To complete the placement of C1, rotate it 180 degrees. Right-click and click 

Rotate 90 twice.  
4. Place it under U1 at X1150,Y1000.  
5. Repeat the steps above to place the remaining capacitors: 

Component Move to 
C2 500 1000 
C3 1950 1550 
C4 700 1700 
C5 700 1350 
C6 1950 900 
C10 1150 1650 

Placing with keepouts 

Use this same method to locate, select, and move oscillator Y1. You will also 
experience the behavior of the placement commands when placement keepouts 
are present. 
Requirement: At this point in the tutorial the DRC mode is set to off.  
To enable placement keepout checking, you must change the DRC mode 
to Prevent. 
1. To enable On-line DRC, type the modeless command drp and press Enter. 
2. With Move active, type the modeless command ssy1 and press Enter to 

search and select Y1. Y1 attaches to the pointer. 
3. Position Y1 at X2050,Y1100 (between U3 and U4), and click to place it. 

Result:  You are prevented from placing a component with a height attribute 
that exceeds the allowable height in the keepout area. 

4. To rotate Y1 90 degrees, right-click and click Rotate 90.  
5. Place Y1 at X400,Y1400. 
6. To disable On-line DRC, type the modeless command dro and press Enter.  
7. Click OK to confirm the operation. 
See also: On-line DRC operation and behavior is covered in the Design 
Verification tutorial. 
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Placing components using Find  
 

You can also select and move components using the Find command. The Find 
command provides a mechanism to quickly search and locate design components 
and automatically apply commands like Select, Highlight, and Rotate 90. 

Placing connector J1 

You will use this method to locate, select, and move connector J1. 
1. Edit menu > Find.  
2. In the Find dialog box, in the Find By list, select Ref. Designator. 
3. In the Ref. Des. Prefix list select J and in the Ref. Designators list J1. 
4. Click Apply.  

Result: J1 attaches to the pointer. Do not close the Find dialog box at 
this time. 

5. In the design area, right-click and click Flip Side.  
6. Click at X1650,Y400 to place J1. 

Placing capacitor C7 

1. In the Find dialog box, select C from the Ref. Des. Prefix list, and C7 from the 
Ref. Designators list.  

2. Click Apply. 
3. In the design area, right-click and click Flip Side to flip C7 to the Secondary 

Component Side.  
4. Place C7 at X400, Y1550. 
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Placing components using Move Sequential 
 

You can select multiple components and automatically move each of the parts 
sequentially. You will use this method to place resistors R1, R2, and R5. 
1. Design Toolbar > Select button. 
2. In the Find dialog box, select Move Sequential in the Action list. 
3. In the Ref. Des. Prefix list, select R. 
4. In the Ref. Designator list, Ctrl+click to select R1, R2, and R5. 
5. Click Apply. 
6. Click Yes to All in response to the message.  

Result: The first component in the group attaches to the pointer. Once the 
first component is placed, the next component in the group automatically 
attaches to the pointer. 

7. Place the resistors at the following locations: 
Resistor Move to 
R1 2050, 550 
R2 2050, 1200 
R5 400, 1700 

8. Close the Find dialog box. 

Placing components using Properties 
 

You can use the Component Properties dialog box to place parts. Use this method 
to place the LEDs and their resistors. These parts are positioned around the arc 
at the right side of the board. 
1. View menu > Extents. 
2. Type the modeless command ssd1 and press Enter. 
3. Right-click and click Properties. 
4. In the Layout Data area, type 3500 in the X box, type 1600 in the Y box, and 

type 315 in the Rotation box. 
5. Click Apply to modify the location and orientation of the part. 
6. Leave the Component Properties dialog box open, and click in the workspace. 

Type ssd2 and press Enter to select D2.  
7. Place D2 and resistors R7 and R6 at the following locations: 

Component Move to 
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D2 3500, 600 with a rotation of 225 degrees 
R6 3675, 925 with a rotation of 255 degrees 
R7 3675, 1275 with a rotation of 105 degrees 

8. Click OK. 

Experiment to place the three remaining components 
 

Place transistor Q1 and its filter capacitors C8 and C9 using any of the 
placement methods previously described in this tutorial. 
Place the components at: 
Component Move To 
Q1 3100 1200 with a rotation of 90 degrees 
C8 2100 400 
C9 2100 1800 
 
Do not save a copy of the design. 

You completed the moving and placing components tutorial. 
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Creating and Editing Traces 

PADS Layout contains several interactive and semi-automatic routing tools 
designed to shorten design time and increase productivity. These tools include 
Dynamic Route Editing (DRE), Bus Routing of two or more traces 
simultaneously, curved traces, mitered trace corners, T-Routing (for tying into 
tracks of the same net regardless of start or end points), On-line Design Rule 
Checking (DRC), and copy routines.  

In this lesson: 

 Pre-routing procedures 
 Using the manual route editor 
 Modifying traces 
 Copying traces 
 Deleting traces 
 Routing plane nets 
 Using on-line design rule checking (DRC) 
 Routing with keepouts and cutouts 

Example of the completely routed PCB 

 

Restriction 

This tutorial requires the General Editing, and Split Planes licensing options. 
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewplaced.pcb in the \PADS Projects\Samples folder. 
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Prerouting procedures 
 

Before you begin routing, you need to perform a few prerouting procedures. The 
procedures vary by individual and by design. The following preparatory steps are 
designed specifically for this tutorial. Follow these steps to receive the full 
benefit of the tutorial. 

Change the color display of items 

To improve visibility and reduce screen clutter while you are routing traces, 
disable the display of items not required for interactive routing. 
1. Setup menu > Display Colors 
2. In the Display Colors Setup dialog box, clear the layer check boxes for the 

Ground and Power plane layers. 
Result: Disables the display of these plane layers. 

3. In the Selected Color area, click the background color, black. 
4. For both component layers (1 and 4) click Ref. Des., Attributes, Keepouts, Top 

Outline, and Bottom Outline to make these items invisible. 
5. In the Selected Color area, click light green. 
6. In the Other area, click Connection to display the connections as 

light green. 
7. Click OK to accept the changes and close the Display Colors Setup dialog box. 

Define a layer pair 

Defining a routing layer pair minimizes the amount of time spent on manual 
layer changes during interactive routing. Pairing routing layers limits layer 
changes to the members of the layer pair. For this four-layer design, the obvious 
routing pair is the Primary and Secondary Component layers. 
1. Tools menu > Options > Routing > General page. 
2. In the Layer Pair area, in the First layer list, select Primary Component Side 

and in the Second layer list select Secondary Component Side. 
3. In the Options area, clear the Show Trace Length check box to facilitate 

routing later in this tutorial. 
Tip: Do not close the Options dialog box. 
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Define the default trace angle 

The trace angle setting determines the degree of adjacent trace segments as they 
are introduced during interactive routing. There are three trace angle settings: 
Angle Setting Description 
Diagonal Adjacent trace segments are limited to 45 degree intervals. 
Orthogonal Adjacent trace segments are limited to 90 degree intervals. 
Any Angle Adjacent trace segments are not limited to any angle. 
 
For the purpose of this tutorial, set the Line/Trace Angle to Orthogonal. 
1. Design page. 
2. In the Line/Trace Angle area, click Orthogonal. 
3. Click OK to close the Options dialog box. 

Set a routing and via grid 

In this lesson, use a routing and via grid to assist in the learning process. 
Set a routing grid and via grid to 8 1/3 mils to accommodate the 8 mil trace and 8 
mil space requirements of the design.  

To set the routing grid and via grid: 

 Type g8.33 and press Enter. 

Enable real width display 

You can choose to enable or disable true width display to see trace widths in 
their real width. The default is to display lines and traces at 8 mils or greater in 
real width. Set the real width display to 0 mils. 

To set the real width display: 

 To display all lines and traces equal to or greater than 8 mils in their real 
width, type the modeless command r0 and press Enter. 

Using the manual route editor 
 

The manual route editor is the core route editing function. Many of the 
operations for defining traces in the route editor resemble other operations 
covered in the tutorials, such as those used for creating polygons and line 
items. This minimizes the learning curve by letting you apply the same skills 
to many areas. 
All connections are converted to traces by selecting the connection and creating 
new corners and layer changes using pointer actions and keyboard combinations. 
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Resize the view 

Zoom in for better visibility. 
1. Highlight the net 24MHz using the highlight net modeless command: type n 

24mhz and press Enter. 
2. Zoom into the upper left corner of the design, centering the view around the 

short portion of the 24MHz net, connecting the oscillator to the resistor. 
3. Type n (without the netname) and press Enter, to unhighlight the net 

24MHz.  

Start routing 

Route with the manual route editor. 
1. With nothing selected, right-click, and click Select Traces/Pins/Unroutes. 
2. On the standard toolbar, in the Layer list, select Primary Component Side to 

set it as the current layer. 
3. Select the short connection of the net 24MHz, between the oscillator and 

the resistor. 
4. Right-click and click Route.  

Result: The beginning of a new trace segment attaches to the pointer. 
Tip: At this point, you are in DRC Off mode. New trace segments are not 
prohibited from shorting to other objects. 

5. Experiment with the pointer movements and trace reactions. Move the 
pointer around and note how one end of the connection attaches to the end of 
a new route segment and the other end remains attached to a pad as end 
point of the connection. This helps you determine where you are going as 
you route.  

On nets with more than one connection, the end point of the connection 
automatically snaps to the nearest pin of the net. Experiment with this reconnect 
feature. 
6. Zoom out and move the pointer in the direction of the lower left corner of the 

board. Once the end point of the trace segment is closer to U7, it detaches 
from its current end point and snaps to U7.  

7. Move the pointer toward the upper left and the trace segment snaps back. 
This feature lets you reconnect traces on-the-fly while routing, avoiding the 
need to manually reorder connections. 

Tip: To exit routing commands at any time, press Esc or click the Undo button on 
the standard toolbar to undo any actions. 
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Change the trace angle mode 

New segments are constrained to 90-degree increments from the origin of the 
trace segment because the current trace angle mode is Orthogonal. 

To change the trace angle mode: 

 Start routing the connection again. While the trace is attached to the pointer, 
right-click, point to Angle Mode, and click Diagonal.  

Once you change the angle mode, move the pointer around. Notice how new 
segments are now constrained to 45-degree increments. 

Add new corners 

While in the route mode, with the end of a new segment attached to the pointer, 
move the pointer and click to add a new corner. 

Delete new corners 

To remove new corners: 

 Right-click and click Backup. 
Alternative: Press Backspace. 

Change layer 

You can change layers the same way you add corners, except Shift+click. You can 
initiate layer changes at the current pointer location or at the last corner location 
while routing. 

To initiate a layer change at the current pointer location: 

 With a new route segment attached to the pointer Shift+click where you want 
to change layers.  
Result: A new via is added at the location of the click. The second layer of the 
routing layer pair is now the current layer. 

To initiate a layer change at the last corner location: 

1. Click to add a new corner. 
2. Move the pointer away from the new corner, right-click and click 

Layer Toggle.  
Alternative: Press F4. 
Result: A via is added to the last corner added. 

Restriction: Vias are not added when On-line DRC is activated and there are 
obstructions to safe placement of the vias. 
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Ending traces 

You can partially complete or end a trace in almost the same manner as adding 
corners and vias: 
 Ctrl+click to end a route. 
Requirement: While routing a segment, right-click, point to End Via Mode and 
click End No Via. If the End Via Mode is set to End Via, Ctrl+click will end a 
route with a via instead. 

Completing traces 

You can complete a route in two ways. 

To complete a route using the Complete command: 

 With a new trace segment attached to the pointer, right-click, and 
click Complete.  
Alternative: Double-click quickly to complete the route. 
Result: The trace is completed from its start to its destination. 

To complete a route without using the Complete command: 

1. With a trace segment attached to the pointer, define a route pattern from its 
start point to its end point, and click the mouse button when the complete 
symbol appears (at the center of its destination pin). 
Result: The trace is completed, in many instances without smoothing or 
cleaning up the route. 

2. Practice routing the short connection of the net 24MHz to completion. Click 
the Undo button to remove previously made routing connections. 

Deleting traces and trace segments 

1. With nothing selected, right-click, and click Select Anything. 
2. Click a segment of a completed trace connection and press Delete. 
3. On the standard toolbar, click the Undo button to undo the deletion. 
4. Shift+click to select the whole pin pair. 
5. Press Delete to unroute the pin pair. 
6. Click Undo. Traces are required for the next steps. 

Modifying traces 
 

Modify traces by selecting a trace segment or via and then using the commands 
on the shortcut menu. You have more freedom to edit routes in DRC Off mode, 
but you can perform route editing in any DRC mode. 
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Experiment with the route editing commands by selecting various route 
segments, vias, and corners. Use the shortcut menus or the keyboard 
shortcuts to initiate the move, stretch, split, add corner, add via, or other 
editing commands.  
See also: The PADS Layout Help 

Rerouting traces 

Another feature of the route editing tools is the ability to change trace patterns 
using the trace creation commands. This is referred to as a reroute. 
1. Select any trace segment. 
2. Right-click and click Route. 
3. To create a new trace pattern and complete it, double-click on any other point 

in the trace or trace segment.  
To complete it on component pins and vias, use the previously mentioned 
trace completion commands during reroute. 

Tip: When you attempt to complete the new segment on another point of the 
trace, the first click of the double-click action attaches the new pattern to the 
existing pattern. The second click completes the reroute. For best results, 
minimize mouse movements while double-clicking. 

Copying traces 
 

You can duplicate traces and trace segments to speed repetitive tasks by copying 
and placing previously created traces. 
1. Select the first segment of the trace you want to duplicate.  
2. Shift+click the ending segment to select a range of traces. 
2. On the Edit menu, click Copy. A copy of the trace attaches to the pointer. 

Alternative: Press Ctrl+C. 
3. Zoom out. With a trace attached to the pointer, move the pointer over a pin to 

which a connection is attached. 
4. Click the pin. A copy of the trace attaches to the pin and another copy 

remains attached to the pointer until you right-click and click Cancel, or you 
press Esc. 

Tip: To orient the trace on the pointer during copying, right-click and use the 
commands on the shortcut menu. 

Deleting traces 
 

At any point in this exercise, you can delete all of the current traces by selecting 
all of the nets and then pressing Delete. 
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1. With nothing selected, right-click and click Select Nets. 
2. Right-click and click Select All to select all nets. 
3. Press Delete and click No when the message "Do you want to undo this 

action?" appears. 

Routing plane nets 
 

For a typical PCB with embedded planes and surface mounted parts, plane net 
routing is limited to routing a small segment out of the pad and terminating it 
with a via to provide contact with the internal plane. 
Before you begin routing plane nets, you need to update the visibility of the 
plane nets. 

Update net visibility 

During the placement stages of this design, the display of certain plane nets was 
disabled to get a clear view of the components during placement. 
Before you can route the plane nets, you need to re-enable the display of 
those nets. 
1. View menu > Nets. 
2. In the View Nets dialog box, select net GND from the View list. 
3. To enable the display of the GND net, select the Traces plus the Following 

Unroutes check box. 
4. To limit the display of the nets to only the routed portions of the nets, click 

All Except Connected Plane Nets. 
5. In the View list, press Ctrl and click to select the Default, +5V, and +12V 

nets.  
6. To disable the display of these nets, clear the Traces plus the Following 

Unroutes check box.  
7. Click OK. 

Perform a length minimization 

Press Ctrl+B to bring the whole PCB in view. The display of the plane nets 
reveals that the net lengths of the plane nets were not minimized.  
 On the Tools menu, click Length Minimization. 

Route end modes 

End modes help you avoid repeatedly using a layer change and end command to 
make every plane connection (you can set a route end mode that always ends 
routes with a via). The three modes are: 
End Via Mode Description 
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End No Via Routes end without a via at the end point of the route. 
End Via Routes end with a via at the end point of the route. 
End Test Point Same as End Via but the via is also a test point. 

 
To change the route end mode: 

1. Right-click and click Select Traces/Pins/Unroutes.  
2. Start routing a connection, and with a route segment attached to the pointer, 

right-click, point to End Via Mode, and click End Via as the new mode. 
3. Find a location for the via, and Ctrl+click to create a pin escape to the plane. 

Route the plane nets 

Using the routing commands from the previous exercise, experiment with 
routing net GND using Ctrl+click to end the routes. Note the presence of the 
plane thermal indicator (an X on the via) each time you end a portion of the GND 
net. This symbol indicates eligibility for a thermal relief; it will make contact 
with the plane. 

Using on-line design rule checking (DRC) 
 

You can enable real-time design rule checking during placement and routing 
operations to ensure that design constraints are maintained throughout the 
design process. This interactive checking is called DRC. You set DRC modes in 
the Options dialog box or by using the dr modeless commands. 
There are four modes of DRC operation: 
DRC Mode Description 
DRC Off Turns off design rule checking.  

Modeless command: dro. 
DRC Ign Clr Ignores all clearance rules but prevents the intersection of 

traces during routing. 
Modeless command: dri. 

DRC Warn Generates error messages for violations. 
Modeless command: drw. 

DRC Prevent  Prevents you from creating violations. 
Modeless command: drp. 

Update net visibility 

Before you can experiment with on-line DRC, you need to update the display of 
some nets. 
1. View menu > Nets. 
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2. In the View Nets dialog box, in the View List, select the Default, +5V, and 
+12V nets. 

3. To enable the display of these nets, select the Traces plus the Following 
Unroutes check box. 

4. To limit the display of the nets to the routed portions, click All Except 
Connected Plane Nets. 

5. Click OK. 

Experiment with routing in DRC Prevent mode 

To enable the DRC Prevent mode: 
 Type drp and press Enter.  
Continue routing traces. Note the presence of the DRC violation indicator – the 
octagonal Guard Band – when you attempt to create spacing violations. 
You can also experiment with the Complete command in DRC prevent mode by 
double-clicking to complete traces. 

Routing with keepouts and cutouts 
 

The components and the design itself contain keepouts. In addition, a board 
cutout was added to the PCB. With DRC prevent enabled, you can't violate these 
areas during route editing. 

Set display colors for keepouts 

Previously, you made keepouts invisible. For the following exercise, turn on the 
display of the keepouts. 
1. Open the file named previewpreroute.pcb in the \PADS Projects\Samples 

folder. Don’t save changes to the previous design. 
2. Setup menu > Display Colors. 
3. In the Display Colors Setup dialog box, click yellow and click Keepouts on the 

Primary Component Side. 
4. Click light blue and click Keepouts on the Secondary Component Side. 
5. Click OK. 

Via keepouts 

The J1 connector decal contains a via keepout. Try to add a via under J1. 
1. If Prevent is not the current DRC mode, type the modeless command drp and 

press Enter. 
2. To search for J1 pin 25, type sj1.25 and press Enter. 
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Result: The pointer is positioned over the pin. The view may change 
depending upon your current zoom level and the center of your current view. 

3. Click the connection to J1.25 and start routing the connection by right-
clicking and clicking Route. 

4. Move your pointer to the left and try to press Shift+click to add a via in the 
keepout outline of J1. 
Result: You cannot insert a via. 

5. Move the trace outside and away from the keepout outline and try to insert 
the via again.  
Result: The via is permitted outside of the keepout. 

6. Press Esc to end the Add Route mode. 

Routing keepouts and board cutouts 

The design contains keepouts and a board cutout to accommodate the shield on 
the bottom side of the PCB. Try to add routes across the keepout and under the 
keepout area on the bottom of the PCB. 
1. With DRC in prevent mode, , to search for U4 pin 9 type su4.9 and press 

Enter. 
2. Click the connection to U4 pin 9 and start routing the connection by right-

clicking and clicking Route. 
3. Move your pointer to the right until it crosses the board cutout.  

Result: The DRC Guard Band appears and you are prevented from adding a 
trace across the cutout. 

4. With the new trace attached to the pointer, create a trace path up and 
around the top of the cutout.  

5. Add a via, continue routing, and attempt to add a trace in the keepout area to 
the right of the cutout.  
Result: The DRC Guard Band appears and you are prevented from adding a 
trace in the keepout area on the Secondary Component Side. 

6. Do not save a copy of the design. 

You completed the creating and editing traces tutorial. 
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Creating Traces with Dynamic Route  

The Dynamic Route Editor (DRE) is another powerful interactive routing 
feature. Instead of indicating each trace corner, as with the Manual Route 
Editor, you simply start the trace and move the pointer in the direction in which 
you want the trace to flow. Trace corners are dynamically added as you move the 
pointer. 
In addition, the Dynamic Route Editor also offers dynamic bus routing. Use bus 
routing to simultaneously route groups of nets such as address and data busses. 

In this lesson: 

 Using the Dynamic Route Editor 
 Rerouting with the Dynamic Route Editor 
 Autorouting with the Dynamic Route Editor 
 Using the bus routing features of the Dynamic Route Editor 

Restriction 

 This tutorial requires the Dynamic Route Editing and General Editing 
licensing options.  

To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewpreroute.pcb in the \PADS Projects\Samples folder.  

Using the Dynamic Route Editor 
 

The core feature of the dynamic route editor is the dynamic route command. You 
use it to convert connections to traces quickly and without DRC errors. 

Enable DRC 

In order to use the dynamic route editor you must be in DRC prevent mode. 
 Type the modeless command drp and press Enter. 

Resize the view 

1. Highlight the net 24MHz using the highlight net modeless command. Type n 
24mhz and press Enter. 
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2. Zoom into the lower left corner of the design, centering the view around the 
longest connection of the net 24MHz (bottom of the net). 

3. To unhighlight net 24MHz, type n (without a netname) and press Enter. 

Route using the Dynamic Route Editor 

1. With nothing selected, right-click and click Select Unroutes/Pins. 
2. To set the angle mode to Orthogonal, type ao and press Enter. 
3. Click net 24MHz at a point close to U7 (bottom of the view), right-click, and 

click Dynamic Route.  
Result: A trace dynamically attaches to the pointer. 

4. Move the pointer vertically on the board, in the general direction of the 
destination of the connection. Notice how dynamic route automatically 
chooses a path around obstacles and creates a trace pattern for you. 
Tip: To back up a route while using Dynamic Route, slowly trace back over 
the newly created trace pattern. 

5. Zoom out. Experiment with dynamically routing by moving the pointer, with 
the route attached, around obstacles, move your pointer closer to the 
destination of the connection and double-click. Notice how the Dynamic Route 
Editor automatically completes the trace and smoothes the pattern. 

Tip: At any point in this exercise you can exit Dynamic Route mode by 
pressing Esc. 
Many of the commands that apply to manual routing also apply when using 
dynamic routing. Backspace removes the last corner added; Shift+click inserts a 
via at the current pointer location causing a level change; Ctrl+click ends the 
route at the current location with or without a via. 
Experiment with routing traces and using the commands while routing. 

Rerouting with the Dynamic Route Editor 
 

You can also use the Dynamic Route Editor to reroute in the same manner as the 
manual route editor.  
1. Right-click and click Select Anything. 
2. Click any trace segment, right-click and click Dynamic Route. 
3. To create a new trace pattern and complete it, double-click on any other point 

in the trace or trace segment. Otherwise, use normal trace completion 
commands when completing on component pins and vias during reroute. 
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Autorouting with the Dynamic Route Editor 
 

You can also autoroute connections on a single layer using features of Dynamic 
Autorouting. The Auto Route command completes routes that do not require a 
layer change. 
1. Design Toolbar > Auto Route button. 
2. Zoom in around the area of the short unrouted connections between J1 and 

U1 (right half of J1). 
3. Click one of the short connections between J1 and U1. Note how the 

connection automatically completes for you. 
4. Experiment with Auto Route on the other short connections and the memory 

bus connections between U1 and U2. 

Using the bus routing features of the Dynamic Route Editor 
 

The interactive routing capabilities let you selectively route all net members of 
large multi-bit data buses simultaneously by compacting the trace patterns into 
multi-trace bus patterns while maintaining all design rules. This results in 
reduced design time and optimal space usage on the PCB. Bus routing uses the 
DRE option, where traces and vias are moved aside to make room for new 
routing without creating clearance violations. 
Before you can initiate a bus route on the tutorial design, you must perform a 
few preparatory steps. 

Resize the view 

Use the Find dialog box to highlight nets and resize the view around the nets 
to route. 
1. View menu > Extents. 
2. On the Design Toolbar, click the Select button to exit Auto Route mode. 
2. Right-click and click Find.  
3. In the Find dialog box, select Nets from the Find By list. 
4. In the Action list, select Highlight. 
5. Scroll through the Nets list, and Shift+click to select the $$$5799,  $$$5801, 

and $$$5803 nets. 
6. Click Apply to highlight the nets. The selected nets are highlighted on the 

design. 
7. Use the zoom commands to resize the view so the three highlighted nets fill 

most of the view. 
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8. With the $$$5799, $$$5801, and $$$5803 nets still selected in the Find dialog 
box, select Unhighlight from the Action list, and click OK to unhighlight the 
nets and close the Find dialog box. 

Set a routing grid and routing angle 

Use the modeless commands to set a routing grid. 
1. For the purpose of this exercise, set the routing grid and via grid to 25. Type 

g25 and press Enter. 
2. To set the angle mode to diagonal, type ad and press Enter. 

Start a bus route 

2. Bus Route button. 
3. Right-click and click Select Pins/Vias/Tacks to limit your selections, as 

necessary, for bus routing. 
4. Area select the three pins of U2 (the large SOIC - lower left pins) connected to 

the nets. 
Result: The interactive bus routing mode is now activated. Initially it appears 
as if you are dynamic routing a single connection, except multiple nets are 
selected. The route currently attached to the pointer is the guide route. Each 
time you add a trace corner or via to this route, the other members of the bus 
will follow the guide route. 
Tip: At any point in this exercise you can exit the routing command operation 
by pressing Esc. 

5. Moving in an upward direction, add a vertical segment a short distance from 
the pin, and click to add a corner to the guide route.  
Result: The other members of the bus catch up to that corner of the 
guide route. 

6. Move the pointer to a point just below the destination pin of the guide route 
and add another corner.  
Result: The other members catch up to the guide route once again. 

7. To complete the bus, right-click and click Complete.  
Result: All members of the bus are completed and smoothed. 

Bus routing with via patterns 

Bus routing can also automatically insert vias in typical via patterns. Whenever 
you add a via to the guide route, the remaining members of the bus are also 
routed to vias. 
1. On the Standard toolbar, click the Undo button to undo the bus routes. 
2. Area select the three pins of U2 once again. 
3. Moving in an upward direction, add a vertical segment a short distance from 

the pin, then Shift+click to add a via to the guide route.  
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Result: A via is added to the guide route. Also, the other members of the bus 
catch up and create a repetitive via pattern. 

4. Press Ctrl+Tab repeatedly to cycle through each of the possible via patterns. 
5. When you cycle to a perpendicular via pattern (three vias arranged 

horizontally), continue routing the bus. 
6. Place the pointer under the destination pin leaving enough room for a via, 

and Shift+click to add vias to the bus. 
If a via for one of the bus members cannot fit into the pattern, the bus router 
pauses and allows you to cycle the via pattern. 
1. Press Ctrl+Tab to cycle the via pattern. 

Result: Once all bus members have a via, you return to bus routing mode and 
the current route becomes the route guide. 

2. Right-click and click Complete to complete the bus. 
3. Do not save a copy of the design. 

You completed the dynamic route editor tutorial. 
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Autorouting with PADS Router 

With the PADS Router Link you can set up autorouting options from PADS 
Layout and then send the design to PADS Router for autorouting. When 
autorouting completes, PADS Router closes and a new session of PADS Layout 
opens containing a routed version of your file. 
The link gives you the option of automatically opening the current design file in 
PADS Router to view routing progress or to autoroute in the background – to 
speed up the process. 

In this lesson: 

 Preparing the design for autorouting 
 Transferring the design to PADS Router for autorouting 

Restriction 

This tutorial requires the General Editing and Split Planes licensing options.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewpreroute.pcb in the \PADS Projects\Samples folder. 

Prepare the design for autorouting 
 

Before you begin autorouting, you must set up your design file for proper 
autorouting in PADS Router. 

Update net visibility 

In the placement tutorial, the display of certain plane nets is disabled for a clear 
view of how the components are interconnected during placement. Before you can 
route the plane nets, you need to enable the display of those nets. 
1. View menu > Nets. 
2. In the View list, select +5V, +12V, GND. 
3. In the View Details area, select the Traces Plus the Following Unroutes 

check box to enable the display of these nets. 
4. Click All Except Connected Plane Nets to limit the display of the nets to only 

the routed portions of the nets. 
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5. Turn off the color for net +5V by selecting it and clicking None in the Colors 
by Net area. 

6. Click OK. 

Perform a length minimization of net connections 

Displaying the plane nets reveals that the net lengths were not minimized. 
 Tools menu > Length Minimization 

Alternative: Press Ctrl+M. 

Transferring the design to PADS Router for autorouting 
 

The process of autorouting PCB designs in PADS Router begins with the PADS 
Router Link. 

Start the PADS Router Link and assign link options 

1. Tools menu > PADS Router. 
2. In the PADS Router Link dialog box, click Autoroute in Foreground in the 

Action area. This allows you to watch the autorouting process. 
3. In the Options area, click Grid and then click Setup.  
4. On the Grids page of the Options dialog box, turn off the Snap to Grid check 

boxes for the Design, Via and Fanout grids.  
5. Click OK. 
6. When you are ready to begin autorouting in PADS Router, click Proceed. In a 

few moments, a session of PADS Router appears and it automatically starts 
autorouting your design. 

Tip: If you are running the PADS Router Link for the first time, the PADS 
Router Monitor appears after you click Proceed. See the next section for more 
information. 
If you ran the PADS Router Link previously, the PADS Router Monitor remains 
on your Windows Taskbar after you click Proceed. Click the PADS Router 
Monitor button on the Taskbar to open the PADS Router Monitor dialog box. 

The PADS Router Monitor 

Use the PADS Router Monitor to track autorouting progress and set options for 
post-routing.  
1. If PADS Router already finished your design, close PADS Router and the 

second PADS Layout window containing the autorouted design. Use the 
PADS Router Link again and immediately proceed with the following steps. 

2. While PADS Router is routing your design, click the PADS Router Monitor 
button on the Taskbar to open the PADS Router Monitor dialog box.  
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3. Click Close When Finished and make sure Load the Resulting File and Exit 
PADS Router on Completion are also selected. 

4. Wait until PADS Router is done autorouting. 
When PADS Router finishes autorouting, the PADS Router Monitor dialog 
box and the PADS Router session closes. The routed file appears in a new 
session of PADS Layout. 

Result: After PADS Router completes autorouting, the PADS Router Link 
returns the file to a new PADS Layout session. At this point, you should close the 
original PADS Layout session to avoid possible confusion due to duplicate 
instances of PADS Layout. 
5. Do not save a copy of the design. 

You completed the PADS Router Link tutorial. 
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Creating Split Planes 

PADS Layout provides automated tools to help you define plane separations and 
divisions quickly. To facilitate the definition of split planes, you can differentiate 
plane nets from other nets by assigning them different colors. You create 
separate plane areas by drawing the lines of separation. 

In this lesson: 

 Setting layer display and plane options 
 Creating a plane area 
 Connecting the plane areas 

Restriction 

This tutorial requires the Split Planes licensing option.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewrouted.pcb in the \PADS Projects\Samples folder.  

Setting layer display and plane options 
 

Before you split the plane layer you must perform a few preparatory steps. 

Assign Colors to the Nets 

To make it easier to distinguish the two power nets, assign different net colors. 
1. View menu > Nets. 
2. From View List, select the net +5V, and then click dark gray from the Color 

by Net area. 
3. Select the net +12V from View List, and then click yellow from the Color by 

Net area. 
4. Click OK. 

Set layer display 

To facilitate the process of defining and splitting the plane, turn off all irrelevant 
layer data. 
1. Setup menu > Display Colors. 
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2. Select the Power Plane layer check box to enable the display of the 
Power Plane. 

3. Clear the Primary and Secondary Component Side check boxes to disable the 
display of both Component layers. 

4. Click OK. 

Setting split plane options 

Before defining the plane area, set the split plane options. 
1. Tools menu > Options > Split/Mixed Plane page. 
2. In the Mixed Plane Display area, click Plane Thermal Indicators. 
3. In the Automatic Actions area, select all of the check boxes except the second 

last option: Use design rules for thermals and antipads. 
4. Click OK. 

Creating a plane area 
 

A split/mixed plane must have a plane area defined before you can divide the 
plane layer into separate areas for each net. There is an automated feature to 
create a plane area by tracing around the board outline. 

Define the plane area 

To quickly create a plane area of the entire board, reuse the shape of the board 
outline for the plane outline. 
1. On the Standard toolbar, in the Layers list select Power Plane, to make it the 

current layer. 
2. With nothing selected, right-click and click Select Board Outline. 
3. Click any segment of the board outline, right-click, and click Select Shape. 
4. Right-click and click Create Plane Area. 
5. The majority of the plane area will be for the +5V net. In the Net assignment 

area, select net +5V from the list and click OK.  
Result: A +5V plane area outline is created just inside the board edge. 

6. Press Esc to deselect the Board Outline. 

Define the plane separation 

Once you define a plane area polygon, use the Auto Separate command to define 
the separation between the two plane areas, similar to what is shown below. 
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To split the plane: 

1. Click outside the board outline to ensure nothing is selected. 
2. If the Drafting toolbar is not currently open, click the Drafting button on the 

Standard toolbar. 
3. On the Drafting toolbar, click the Auto Plane Separate button. 
4. To set a design grid of 25, type g25 and press Enter. Select an edge of plane 

+5V to begin defining the plane separation. 
5. Right-click and click Diagonal. 
6. Define a path that separates all points of the net +12V from net +5V. There is 

no definitive shape for the +12V plane area, just make certain the area you 
define includes all +12V pins and no gray colored +5V pins. 
Tip: Use Backspace to delete new corners or to back up while defining the 
plane separation. 

7. When you complete the separation, position your pointer over an edge 
segment of the +5V plane polygon and double-click to complete the operation. 
Two new plane polygons appear. 
Tip: If you get the error, “All corners must be within the plane area polygon”, 
try extending the line outside the plane area and double-click to complete. 

8. In the Assign Net to Selected Polygon dialog box, if the upper outline is 
selected, select +5V from the Choose Existing Net list and click OK. If the 
lower outline is selected, select +12V. 

9. When the adjacent outline is selected, select the other netname from step 8 
and click OK. 

10. Click Esc to exit Auto Plane Separate mode. 
11. Press Ctrl+B to bring the whole board in view. 
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Connecting the plane areas 
 

Now that you defined the planes, you must connect them to see the full effect of 
the split.  
1. Tools menu > Pour Manager > Plane Connect tab. 
2. Select Power Plane in the Layers list. 
3. Click Start and Yes to proceed with connecting the planes. 
 Tip: A therm.err report might open if some thermal connections can’t be 

made based on how the separation line was drawn. Close it. 
4. In the Pour Manager, click Close. 
5. Do not save a copy of the design. 

You completed the split planes tutorial. 
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Creating Copper and Pour Areas 

Using copper pouring and area filling in PADS Layout, you can quickly produce 
and edit insulated copper areas for shielding, power and ground supply, and 
thermal dissipation. 

In this lesson: 

 Creating the copper pour outline 
 Flooding the pour outline 
 Toggling pour and hatch outlines 
 Editing the copper pour hatch 

Restriction 

This tutorial requires the Copper Flood, Drafting Editing and General Editing 
licensing options.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewsplit.pcb in the \PADS Projects\Samples folder.  

Set Layer Display 
To facilitate the process of defining the pour outline, turn off all irrelevant 
layer data. 
1. Setup menu > Display Colors. 
2. In the Display Colors Setup dialog box, clear the Ground and Power Plane 

check boxes to disable the display of both Plane layers. 
3. Click OK. 

Creating the copper pour outline 
 

A pour outline defines the boundaries of the copper pour area. You use the Flood 
command to fill the area defined by the pour outline with copper hatching. After 
flooding a pour outline, its pour outline is temporarily invisible. The pour outline 
and the copper hatching are not displayed at the same time. In the following 
exercise, you will define and flood a pour outline. 
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Set the grid and the current layer 

1. To set the design grid to 25, type g25 and press Enter. 
2. On the standard toolbar, in the Layer list, select Primary Component Side to 

set it as the current layer. 

Define the pour outline 

1. If the Drafting Toolbar is not open, click the Drafting Toolbar button. 
2. Copper Pour button. 
3. Right-click and click Rectangle. 
4. Position the pointer at X2500,Y1875 and click to start drawing the rectangle.  

Tip: If the pointer increments aren't 25, the pointer isn't snapping to grid. On 
the Tools menu, click Options. Under Grids and Snap, click Grids. For the 
Design Grid select the Snap to Grid check box. Click OK to apply the change 
and close the Options dialog box.  

5. Move the pointer toward the lower right corner of the board and click again 
at X3000,Y325 to complete the rectangle. 

Assign a width and net 

1. In the Add Drafting dialog box, in the Width box, type 12. 
4. In the Net assignment area, select GND from the list, and then click OK to 

apply the changes and close the dialog box.  

Modify the pour outline 

1. Press Esc to exit Copper Pour mode. 
2. Press Esc again to deselect the pour outline. 
3. Right-click and click Select Documentation. 
4. Select the right edge of the rectangle you just created. 
5. Right-click and click Pull Arc. 
6. Pull the right edge of the pour outline into an arc that is slightly inside, and 

concentric with, the arc in the board outline.  
7. Click to complete the arc. 

Flooding the pour outline 
 

Now you can flood the pour outline. The flooding operation creates a hatching 
pattern that fills the area enclosed in the pour outline. 
1. Right-click and click Select Shape to select the whole pour outline. 
2. Right-click and click Flood. 
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3. Click Yes to the "Proceed With Flood?" message. 
After flooding the pour outline, you can see the area of poured copper. In 
addition, an error report may appear detailing the pins or vias having two or less 
spokes. If so, review the error report and close the window before proceeding. 

Toggling pour and hatch outlines 
 

When you flood the pour outline, the pour outline is replaced with hatch outlines 
and polygons. The hatch outline is the shape of the polygon, and the hatch 
pattern fills the shape. 
The pour outline is still present in the design; you just can't see it until you 
toggle the display from hatch outline to pour outline. 
1. Type po and press Enter. This command switches between displaying the 

pour outline and the poured copper hatch inside it. 
2. Type po and press Enter again to revert to the display of the hatch outline. 

You completed the copper pour tutorial. 
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Adding Dimensioning 

PADS Layout provides you with tools to document the physical size and shape of 
your PCB. You can choose between standard or datum dimensioning, and you 
have complete control over the format of the dimension to help you conform to 
corporate or industry standards. 
You access these tools within the Automatic Dimensioning toolbar. 

In this lesson: 

 Setting the dimensioning options 
 Adding a horizontal dimension 
 Adding a vertical dimension 
 Adding a leader dimension 
 Adding an arc dimension 
 Dimensioning the cutout 

Restriction 

 This tutorial requires the Drafting Editing licensing option.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewpour.pcb in the \PADS Projects\Samples folder.  

Change the view and color display 

Before you begin the process of setting design options and adding dimensions, 
you must make a few adjustments to the zoom level and color display. 
1. Change the zoom level so that the board outline fills three quarters of the 

viewing window, leaving enough working space around the PCB to add 
the dimensions. 

2. On the Setup menu, click Display Colors.  
3. In the Display Colors Setup dialog box, clear the Primary and Secondary 

Component Side layer check boxes. 
4. Scroll through the layers and on the Drill Drawing Layer (layer 24), assign 

the color red to both 2D Lines and Text. 
5. Click OK. 
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Setting the dimensioning options 
 

Before you begin adding dimensions, you must assign a few options. 

Setting the units 

The current unit setting establishes the units expressed in the dimensions. If the 
current units are set to inches, then all dimensions are expressed in inches. 
Set the current units to Inches. 
1. Tools menu > Options > Global > General. 
2. Click Inches in the Design Units area. 

Assigning a layer for the dimension items 

You can choose the layer assignment for the text and line item portions of 
the dimension. 
1. Dimensioning > General. 
2. In the Layers area, click the Drill Drawing layer for both Text and Lines. 

Assigning text properties 

You can also assign options for how the numbered text appears in 
the dimension. 
1. Dimensioning > Text. 
2. Delete the Inches suffix by double-clicking in the Suffix box and 

pressing Delete. 
4. Click Horizontal as the Default Orientation. 
5. Click Inside as the Default Position. 
6. In the Precision area, type 2 in the Linear box, and type 0 in the Angular box. 
7. In the Displacement area, click Centered. 
8. Click OK. 

Add a horizontal dimension 
 

Once you complete the assignment of the options, you can add dimensions to the 
design. First, add a dimension for the horizontal length of the PCB. 
1. Right-click and click Select Board Outline. 
2. Dimensioning Toolbar button. 
3. On the Dimensioning toolbar, click the Horizontal button. 
4. Right-click and click Snap to Corner. A check mark indicates the 

active mode. 
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5. Click the left vertical segment of the board outline polygon. An alignment 
marker appears. 

6. Right-click and click Snap to Midpoint. 
7. Select a point along the arc on the right side of the board outline. A new 

dimension is created and is attached to the pointer. 
8. Place the new dimension above the board outline. 
Tip: Click the Redraw button on the standard toolbar to clear the alignment 
markers from your view. 

Add a vertical dimension 
 

Now add a dimension for the vertical length of the PCB. 
1. Vertical button. 
2. Right-click and click Snap to Corner. 
3. Select the top Horizontal segment of the board outline near the left side 

of the board. Select the bottom horizontal segment of the board outline 
near the left side of the board. A new dimension is created and is attached 
to the pointer. 

4. Place the new dimension to the left of the board outline. To redraw the view 
press Ctrl+D. 

Add a leader dimension 
 

The two corners on the left edge of the board outline are mitered. Add a leader 
dimension to call out the details of the chamfers. 
1. Leader button. 
2. Select a point near the center of the chamfer at the bottom left of the board 

outline. A new leader dimension attaches to the pointer. 
3. Move the pointer down and to the left, and double-click to complete the 

leader line.  
4. In the Text Value dialog box, type .035 x .035 2 PLACES and click OK. 

 
Add an arc dimension 

 

To define the size of the arc on the right side of the PCB, use a radial dimension. 
1. Arc button. 
2. Select a point along the arc of the board outline. A new dimension attaches to 

the pointer. 
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3. Click to place the arc dimension. 
Tip: To remove leading or trailing zeros from the dimension text, enter Select 
mode (press Esc). Right-click and click Select Documentation. Double-click on the 
dimension text and modify the text string in the Dimension Text Properties 
dialog box. 

Dimensioning the cutout 
 

Experiment with the dimensioning features to define the size and location of the 
cutout in the PCB. Use the routines in this lesson to dimension the cutout. 
See also: PADS Layout Help 
 Do not save a copy of the design. 

You completed the automatic dimensioning tutorial. 
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Checking for Design Rule Violations 

The Verify Design command lets you check your design for clearance, 
connectivity, high speed, and plane errors. This advanced space checking is quick 
and accurate to .00001".  
You can check the Clearance rules and perform Connectivity checks to ensure 
that your design is fully routed. High-speed Checking searches for 
electrodynamic violations to avoid problems with critical signal and high-speed 
designs. Plane net checks verify that thermals are generated on plane layers. 
You can modify traces to intentionally create some spacing errors, and then try 
the checking and reports routines. 

In this lesson: 

 Performing a design rule clearance check 
 Viewing spacing errors 
 Checking PADS Router-specific rules 

Restriction 

This tutorial requires the Verify Design licensing option.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewdim.pcb in the \PADS Projects\Samples folder.  

Performing a design rule clearance check 
 

The Verify Design tools in PADS Layout scan the design database looking for all 
design rule violations. If errors are detected, they are identified with a graphic 
error symbol and itemized in the Verify Design dialog box. 
Tip: To check the entire board, you must display the entire board. On the 
standard toolbar, click the Board button. 
1. Tools menu > Verify Design. 
2. In the Verify Design dialog box, in the Check area, click Clearance. 
3. Click Setup.  
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4. In the Clearance Checking Setup dialog box, make sure the Net to All, Board 
Outline, Keepout, Drill to Drill and Body to body check boxes are selected. 

5. Click OK to accept the changes and close the Clearance Checking Setup 
dialog box. 

6. Click Start.  
Result: The Status Bar indicates the layer being checked. A progress 
indicator displays the degree of checking. The previewdim.pcb design should 
contain two errors. 

Viewing spacing errors 
 

After the verify design operation has completed, a dialog box appears indicating 
errors found. View the marked error in the design. 
1. In the notification window, click OK to view the errors. All violations detected 

are identified with a small graphic symbol. Different symbols are used to 
identify violations for each different check type.  
See also: The "Interpreting Error Markers" paragraph in the “Verifying the 
Design” topic in PADS Layout help 

2. Leave the Verify Design dialog box open and zoom in to any area of 
the design. 

3. Clear the Disable Panning check box to enable automatic panning of your 
view to the selected error. 

4. In the Verify Design dialog box, select an error from the Location list. 
Result: The screen redraws, displaying the selected error in the center of  
the view. The Explanation list describes the error in detail. 

5. Do not save a copy of the design. 

Preparation 

Open the file named previewrouterverify.pcb in the \PADS Projects\Samples 
folder. 

Checking PADS Router-specific rules 
 

You can also check PADS Router-specific advanced routing features while the 
design is open in PADS Layout. Set Verify Design to check the design with PADS 
Router by selecting the Latium Design Verification option. 
1. Tools menu > Verify Design. 
2. In the Check area, click Latium Design Verification, and click Setup. 
3. In the Latium Checking Setup dialog box, select the items you want to check 

and click OK. 
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4. Click Clear Errors to remove existing error markers from the design. 
5. Set the area to check by scaling the design in the PADS Layout workspace.  

Only the visible part of the design and only visible objects will be verified 
during Clearance checking. Other types of checking will verify objects in the 
whole design. 

6. In the Verify Design dialog box, click Start to verify the design. 
Result: When you run Latium Design Verification, the following occurs: 
 The design is saved on disk under a temporary name. 
 A new instance of PADS Router starts in the background. 
 PADS Layout sets the necessary Design Verification options in PADS 

Router. 
 PADS Router saves the design, loads the design back into PADS Layout, 

and closes. 
 Verify Design reads error information from the design database, displays 

error markers in the workspace, and displays error descriptions in the 
Verify Design dialog box. 

7. Review the errors and close the Verify Design dialog box when finished. 
8. Do not save a copy of the design. 

You completed the design verification tutorial. 



Updating the Schematic 75 

Updating the Schematic 

To facilitate the design engineering process, PADS Layout offers Engineering 
Change Order (ECO) features. 

In this lesson: 

 Generating ECO records 
 Updating your PADS Logic schematic 

Restriction 

This tutorial requires the ECO licensing option.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewassy.pcb in the \PADS Projects\Samples folder.  

Generating ECO records 
 

In the typical engineering environment, design modifications are documented by 
an Engineering Change Order (ECO). Implementing ECOs in a design may 
require pin and gate swaps, part deletions or additions, net deletions or 
additions, renaming components, renaming nets, or changing part types.  
You can perform ECO changes and record them in an ASCII file named with a 
*.eco extension. This file, in its native format, can be read into PADS Logic for 
backward annotation of the schematic. 

To enable ECO functions: 

1. ECO Toolbar button. 
Tip: If the ECO Options dialog box does not appear, click the Options button 
on the ECO toolbar. 

2. In the ECO Options dialog box, select the Write ECO file check box and clear 
the Append to File check box. Leave the file name as previewassy.eco. 

3. Select the Write ECO File after closing ECO Toolbar check box. 
4. Click OK. 
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Automatic component rename 

One feature of the ECO function is automated part renumbering. You do this by 
defining the components to renumber and specifying a numbering pattern. 
1. Auto Renumber button. 
2. In the Auto Renumber dialog box, if all the prefixes in the Prefix List are not 

already selected, click Select All. 
Tip: The Select All button changes to UnSelect All when everything is 
already selected. 

3. Change the Cell size: On X 1, On Y 1. 
4. Click the Left to right and top to bottom button in both Top and 

Bottom areas. 
5. In the Start Renumbering from area, click Top. 
6. Click OK to start automatic renumbering. 
7. On the Standard toolbar, click the ECO Toolbar button to close the ECO 

toolbar and to write the changes to the ECO file. 
Result: The parts are renumbered. A before and after list is created in standard 
PADS Layout ECO format in a file that is located in the  
\PADS Projects\Samples folder with the name previewassy.eco. 

Updating your PADS Logic schematic 
 

You can import the resulting ECO file with the renumbered parts directly into 
PADS Logic and instantly update your schematic. 
Requirement: This section of the lesson requires PADS Logic. If you don't have 
PADS Logic, skip this section. 

Preparation 

If it is not already running, start PADS Logic and open the file named 
preview.sch in the \PADS Projects\Samples folder. 

Import the ECO File 

Examine a few of the reference designators in the schematic. Now import an 
.eco file. 
1. PADS Logic File menu > Import. 
2. Click No if the message "Save file before loading" appears. 
3. In the File Type area of the dialog, change ASCII File (*.txt) to ECO Files 

(*.eco). 
4. Select the previewassy.eco file in the \PADS Projects\Samples folder, and 

then click Open. 
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5. In the “ECO input completed” notification window, click OK. 
Result: All reference designators on the schematic are updated and the 
schematic is redrawn. 

6. Do not save a copy of the design. 

You completed the reports and engineering change orders tutorial. 
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Creating Reports and CAM Files 

Whether you want to print a quick rendering of the layout in progress or commit 
the final design to finished artwork, the Computer Aided Manufacturing (CAM) 
commands offer a complete selection of printing and plotting options.  

In this lesson: 

 Generating reports 
 Creating a new CAM directory 
 Creating CAM documents 
 Plotting layer selections 
 Setting up the device 
 Saving and plotting CAM documents 
 Creating multiple documents 

Restriction 

This tutorial requires the CAM, Copper Flood, Split Planes licensing options.  
To determine whether you can proceed: 
 On the Help menu, click Installed Options.  

Preparation 

If it is not already running, start PADS Layout and open the file named 
previewassy.pcb in the \PADS Projects\Samples folder.  

Generating reports 
 

Create a parts list report 

1. File menu > Reports. 
2. In the Reports dialog box, click the Parts List 1 report and click OK. The new 

report appears in your default text editor. After reviewing the report, close 
the text editor. 

Recommendation: More advanced preformatted reports and tools exist in the 
Basic Scripts interface. On the Tools menu, point to Basic Scripts and then click 
Basic Scripts on the submenu. 
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Creating a new CAM directory 
 

All of the processing performed that results in files or CAM data is stored in a 
single project folder for each design. You can save and reuse it for the current 
design or copy it to other designs. 

Flooding your design 

The pour areas of your design, including the plane layers, appear unfilled 
because the fill data is not stored with the file. You can recreate it with a 
few clicks. 
1. Tools menu > Pour Manager > Flood tab. 
2. Click Flood All. 
3. Click Start to connect all pour outlines and click Yes to confirm the connect 

operation. 
4. Click the Plane Connect tab. 
5. Click Start to flood all plane outlines and click Yes to confirm the flood 

operation. 
6. Click Close. 

Creating the CAM folder 

In the CAM portion of the program, you define the type of plots, the output 
devices, and various data to create artwork or check plots for your design. 
1. File menu > CAM. 
2. In the Define CAM Documents dialog box, in the CAM Directory list, click 

<Create>. 
3. In the CAM Question dialog box, type preview and click OK.  
Result: The list reflects the subfolder name. You created a project folder in which 
to store all your CAM files. The new folder is located inside the CAM subfolder. 
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Creating CAM documents 
 

Each output of a pen plot, photoplot, or NC Drill is considered a CAM document. 
Each CAM document definition contains all the data for the plot type, selected 
items, and other parameters. 
1. Click Add.  
2. In the Add Document dialog box, in the Document Name box, type Photo - 

Primary Component Side. 
3. In the Document Type list, click Routing/Split Plane.  
4. In the Layer Association dialog box, click OK to accept the Primary 

Component Layer.  
The Summary area displays the layer name and default selections. The next 
step is to configure the layers selections. 

5. In the Output Device area, click Photo to assign a Gerber photoplot file as the 
output of this document. 

Plotting layer selections 
 

Add additional objects to the plot using the Layers feature. 
1. In the Customize Document area, click Layers.  
2. In the Select Items dialog box, in the Other area, select the Board Outline 

check box. A black box appears next to the Board Outline item. 
Tip: Primary Component Side appears in the Selected area. The Items on 
Primary area is highlighted in the color black for selected pads, traces, lines, 
vias, copper, and text. These entries match the default output when 
processing routing layers.  

3. Click Preview to preview your selections and see how they might appear on 
the photoplot. 

4. In the Zoom area of the Preview window, click Board to fit the layer image to 
the view. 
Tip: Zooming in the Preview window works the same as zooming in a design; 
drag up to zoom in and drag down to zoom out. You must, however, use the 
left mouse button to zoom instead of using the middle mouse button. By using 
the Zoom buttons, you can also zoom to the board limits or the extents of the 
database to include items outside the board outline.  

5. Click Close. 
6. In the Select Items dialog box, click OK. 
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Setting up the device 
 

For the final setup, determine the proper output device and the settings for that 
device. 
1. In the Add Document dialog box, click Device Setup.  
2. In the Photo Plotter Setup dialog box, click Add. 
3. Type 10 (or some other number if 10 is used) when prompted for the Aperture 

Number. 
4. Click OK. 
5. In the Flashes area, click the Round button for a round aperture.  
6. Type .02 in the Width box.  
7. Click Augment and answer Yes to automatically fill in the rest of the 

apertures required to process a photoplot of the Primary Component Side. 
Tip: If the Augment on-the-fly check box is selected, the required apertures 
are calculated at plot time and then added to the list automatically.  

8. Click OK. 

Saving and plotting CAM documents 
 

Now that you selected all the items to include in the photoplot and defined the 
apertures to augment on-the-fly, you can process the photoplot. 
1. Click OK to close the Add Document dialog box and to save the document 

settings. 
2. In the Define CAM Documents dialog box, click Run to create the 

photoplot file. 
3. In the prompt, answer Yes. 
Result: The file art001.pho, which is the default name, is written to the  
\PADS Projects\CAM\preview folder that you created at the beginning of this 
section. An aperture report file called art001.rep, listing apertures used in the 
design, is also created and placed in that folder. 

Creating multiple documents and the Aperture Report 
 

The Document Name box displays a list of all created document names. It 
currently contains the document name of the file you created above, Photo - 
Primary Component Side. If additional documents exist, they appear here also. 
You can select multiple documents in the Document Name box and click Run to 
plot multiple documents. 
1. Click Aperture Report. You are prompted to create a file called preview.rep. 
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2. Click Save to create a report containing a summary of photoplot apertures 
contained within the specified subfolder.  
Result: The report appears in the default text editor. Review the report and 
close the text editor before proceeding. 

3. Click Close in the Define CAM Documents dialog box to exit CAM, and click 
No to decline saving the created file. 

4. Do not save a copy of the design. 

You completed the computer aided manufacturing (CAM) tutorial. 
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